LEARNING

In this chapter, you will learn about :

©  Computer Memory ©  Units of Memory
o Types of Computer Memory

COMPUTER MEMORY

CPU is the brain of a computer. It processes all the information it receives
through input devices and stores it in computer memory. A computer also has
a memory just as we have to remember things. The storage capacity of a
computer is called its memory. Computer memory is used for storing data and
instructions.

UNITS OF MEMORY

A computer can understand only binary language. It processes and stores data
and instructions in the form of binary language. A binary language consists of
O’s and 1’s called binary digits or bits.

A bit is the smallest unit of information which a computer can process and
store. A group of 4 bits is called a nibble and a group of 8 bits is called a byte.
A computer memory is stored in the form of bits and bytes. Every computer
has a certain amount of memory. The memory capacity of a computer
determines how much data can be stored in the computer.

There are other higher units of measuring memory as given below :

1 Byte = 8 Bits

1 Kilobyte (KB) = 1024 Bytes (2'° Bytes)
1 Megabyte (MB) = 1024 KB (210 KB)

1 Gigabyte (GB) = 1024 MB (2'° MB)

1 Terabyte (TB) = 1024 GB (2'° GB)
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1 Petabyte (PB) = 1024 TB (2'° TB)

1 Exabyte (EB) = 1024 PB (21° PB)
1 Zettabyte (ZB) = 1024 EB (210 ER)
1 Yottabyte (YB) = 1024 ZB (219 ZB)
FactKnO'W' ~ Local Knowledge

Byte is the unit of measurement of a computer memory.

TYPES OF COMPUTER MEMORY

Computer memory can be classified into two categories. They are primary
memory and secondary memory.

1. Primary Memory- (i) RAM, (ii) ROM

2. Secondary Memory- (i) CD-ROM, (ii) Hard Disk, (iii) Blu-ray Disc, (iv) DVD,
(v) Pen Drive, (vi) Memory Cards

Primary Memory

Primary memory is also known as the main memory or the internal memory. It
Is the in-built memory that is fixed inside the CPU. It stores data or instructions
currently used by the computer. The minimum size of primary memory is 256
MB. We can increase its size any time.

Primary memory can be divided into two parts — RAM and ROM.

1. RAM : RAM stands for Random Access Memory.
RAM refers to read and write memory. Information can
be written onto and read from RAM. RAM is volatile in
nature. So, whenever power fails or the computer is
switched off, all the information that has been stored in
RAM is lost. It stores information on a temporary basis.

2. ROM : ROM stands for Read Only Memory. It keeps
the data permanent. It is non-volatile in nature. It
retains the data even when a computer is switched off.

In most computers, ROM is used for storing a special
program called BIOS (Basic Input Output System). This program helps to load
the operating system when the computer is switched on.

There are three different kinds of ROM.
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(i) PROM PROM stands for Programmable Read Only Memory. It is a
memory chip on which we can store a program. But once it
has been used, we cannot erase its stored information or use
it to store something else. It can be programmed only under
special conditions.

(i) EPROM  EPROM stands for Erasable Programmable Read Only
Memory. We can erase its stored information by exposing it to
ultraviolet light. EPROMs are cheap and reliable and hence
they are widely used.

(i) EEPROM EEPROM stands for Electrically Erasable Programmable Read
Only Memory. The information written on it can be erased
using electrical signals.

Secondary Memory

Secondary memory is known as auxiliary memory or external memory. It is
used to store information for a longer period of time. It is needed because
primary memory of a computer is insufficient to store and save large amount of
data for future reference and retrieval.

Let us now discuss some of the secondary storage devices.

1. CD-ROM : CD-ROM stands for Compact Disc-Read Only
Memory. It is popularly known as CD. It is the most commonly /
used storage device. It is a thin circular disk with a reflective (ff”?
metal coating. The diameter of a CD ranges from 10 cm to 30
cm. A typical CD measures 4.7 inches in diameter. One CD can o

store 600 to 750 MB data on it.
Nowadays, we get two kinds of CDs.

CD-R  CD-R stands for Compact Disc-Recordable. In this type of CD, data
once written cannot be changed or deleted.

CD-RW CD-RW stands for Compact Disc-Rewritable. Data in this CD can
be erased or rewritten.

2. Hard disk : A hard disk is also known as a fixed disk. It is
the main secondary storage device found inside the cabinet
of a CPU. It can store large amount of data upto 8 TB. All
the work done on a computer can be stored in a hard disk. A <
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hard disk is made up of many rigid metal plates coated to store data
magnetically.

Nowadays, external hard disks are also available. They are small in size and
can be carried anywhere.

3. Blu-ray Disc : A Blu-ray disc is similar to a CD or a DVD in
appearance but it can hold up to 128 GB of data. It uses Py
blue-violet lasers to read and hold a large amount of data. A = = s
Blu-ray reader is required to use a Blu-ray disc. It is mainly
used for storing very high-quality video files and video games

that require large amount of storage space.

\ 4. DVD : DVD stands for Digital Versatile Disc or Digital Video
R = | Disc. It is very similar to a CD but can store much more data. It

\\_/ is an optical disc storage device. Its capacity may range from
4.7 GBto 17 GB.

5. Pen Drive : A pen drive is also known as a flash drive. It is very small in
size. It can be used to store and transfer data from one computer
to another. It can be connected to the USB (Universal Serial Bus)
port of a computer. It can easily be carried in the pocket. It can
store a large amount of data like 1 GB, 2 GB or more.

6. Memory Cards : A memory card is used to store data in various electronic
devices like mobile phones, digital cameras, MP3 players
and many other portable devices. It is small in size and can
store upto 32 GB of data. We can transfer the data stored in
a memory card to our computer.

Fact KD_OW . Local Knowledge

Floppy disks and Zip disks are also examples of secondary storage devices. They are outdated and
not in use now.

F‘%?g; z \

Match the following :

4 ey D Becocanive.
/ eer

1. RAM (@) non-volatile in nature
2. CD (b)  volatile in nature
3. ROM (c)  known as flash drive
\4. Pen Drive (d)  stands for compact disc )
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The storage capacity of a computer is called its memory. Computer memory is used for storing data and

O © © © ¢

instructions.

A bit is the smallest unit of information which a computer can process and store.
A group of 4 bits is called a nibble and a group of 8 bits is called a byte.
Computer memory is of two types — primary memory and secondary memory.
Primary memory is of two types — RAM and ROM.

ROM is of three types — PROM, EPROM and EEPROM.

Tick (V) the correct answer :

1. Which of the following is not a secondary storage device?

(a) Hard disk (b) RAM (c) CD
2. A group of 8 bits is called—
(a) Bit (b) Nibble (c) Byte
3. Which of the following is volatile in nature?
(a) RAM (b) ROM (c) Pen drive

4, 1 TB is equal to—
(a) 1024 MB (b) 1024 KB (c) 1024 GB
5. Which type of memory is known as main memory?
(@) Primary memory (b) EEPROM
(c) Secondary memory (d) RAM

Write ‘T’ for true and ‘F’ for false in the given circles :
1 ROM is volatile in nature.

2 A hard disk is also known as a fixed disk.

3. 1 MB is equal to 210 KB.
4
5

Secondary memory is also known as external memory.

(d) Blu-ray disc

(d) Kilobyte

(d) DVD

(d) 1024PB

In most computers, RAM is used for storing a special program called BIOS.
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C. Fill in the blanks :

1. A computer memory is stored in the form of and

2 A pen drive is also known as a

3. A computer can only understand language.

4 A uses blue-violet lasers to read and hold a large amount of
data.

5. A memory is the in-built memory that is fixed inside the CPU.

D. Answer the following questions :

Explain primary memory.

What do you mean by secondary memory?

What is computer memory? Also, name its types.
Explain blu-ray disc and memory cards.

. What is the difference between RAM and ROM?

o whe

2

=(rea'lfiVﬂ'.H Ski"S ] Dﬂi Art Integrm

Draw and colour the picture of a pen drive in your notebook.

Experience-Based Questions Higher Order Thinking Skill

Observe the given picture and answer the following questions :
(a) Identify the storage device.
(b)  Which type of memory is this?
(c) What is the nature of this memory?

Think & Answer Life Skills & Values |
Your friend is trying to open CPU of a computer in the lab. What will you do?

Activity Work Cutting & Making Skills
Collect the pictures and prepare a collage on ‘Computer memory’.

PiSCUSSiOh Communication |

Discuss the types of primary memory in class in detail.

Teacher's Help
©  Demonstrate how to use CDs, DVDs and pen drives to students.
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" = Personalizing the
S Windows 10 Environmemt

LEARNING [0]8j)ye(e) Y|

In this chapter, you will learn about :

©  Opening the Personalization Settings ©  Setting the Desktop Background
©  Changing the Colour Scheme used throughout Windows 10 ©  Customizing the Windows 10 Lock Screen
©  (Changing the Windows 10 Theme ©  (Changing the Appearance of the Start Menu

Microsoft Windows is the most popular operating system. MS Windows has
many versions.

Some of the popular versions of Windows are Windows 98, Windows XP,
Windows Vista, Windows 7, Windows 8, Windows 10 and Windows 11.
Windows 11 is the latest version of MS Windows.

The first screen that appears after loading the operating system with labelled
pictures on it is called Desktop. It consists of icons and taskbar.

One of the most popular ways of personalizing a Windows 10 PC has to be
changing its appearance. There are quite a few ways to change how our
Windows 10 computer looks, but the first step for all of them is accessing the
personalization settings.

OPENING THE PERSONALIZATION SETTINGS
To open the personalization settings, follow any one of the methods.

First Method :

| Settings - =] X

53 seTTiNGS

o 8 o Z K
, Sy.il.e Devaces Newmn::a.m‘ﬂnet Personatzation Accounts
e < = O
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Step 1. Click on the Start button.
Step 2. Click on the Settings option.
Step 3. Click on the Personalization option.

Second Method :

Step 1. Right-click on the blank area on the desktop.

Step 2. Click on the Personalization option.

Undo Delete

Graphics Properties...
Graphics Options >

Hew > IR

1 Display settings
& Personalize

< Settings
€03 PERSONALIZATION
Background 5
Preview
Colors
Lock screen

Themes

Start

Background

Picture e

Choose your picture

Browse

Choose a fit

Center

Find a setting

The PERSONALIZATION window appears. It allows you to :
©  Change the colour scheme used throughout Windows 10.

Set the desktop background.

Change the Windows 10 theme.
Customise the Windows 10 lock screen.
Change the appearance of the Start menu.
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Write down the steps of opening the personalization settings.

. J/

SETTING THE DESKTOP BACKGROUND

The picture appears as a background on the desktop is called wallpaper. Our
choice of desktop background usually reflects our Bgackground

personal taste— what we like to see when our application awe
is minimized or closed. We can set our desktop

background to any of the three types of background-
Picture, Solid color and Slideshow.

Slideshow

Picture

To set a picture as a desktop background, ; = —
follow these steps : e .

Step 1. Select the Background option. —

S

Step 2. Select the Picture option from
Background drop-down menu,

Step 3. Select the desired picture.

Step 4. Select the suitable option from the
Choose a fit drop-down menu. -
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Solid Color | @ resomanron

To set a solid color as a desktop |~

Backpround

background, follow these steps : | e

Step 1. Select the Background option. B

Step 2. Select the Solid color option from
Background drop-down menu.

Step 3. Select the desired colour,

Slideshow

To use a slideshow for desktop background, open the PERSONALIZATION
window and follow these steps :

Step 1.
Step 2.

Step 3.
Step 4.

Step 5.

Select the Background option.

Select the Slideshow option from Background drop-down menu. The
Select Folder dialog box appears.

Click on the

Browse button. __,:....._ [ ———
Select the -~ s 2
folder. i . ' Ra

Click on the | :f"‘”_:ﬂ:u

Choose this '::“m :

folder button. =T | ot
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Step 6. Specify the time after which you want the picture to change by
choosing a value from the Change picture every drop-down menu.

_St_gp /. Select the suitable option__f__rom the Choose a fit drop-down menu.

| Themes

CHANGING THE COLOUR SCHEME USED THROUGHOUT WINDOWS 10

By default, Windows 10 will use a black taskbar, a dark grey Start menu, and
the accent colour (the colour used on tiles, borders, in the action center and on
taskbar icons) will be automatically chosen from your background. These are
pretty easy to change, though— so read on to learn how to tweak those colours
to your own preferences.

To change the colour scheme used throughout Windows 10, open the
PERSONALIZATION window and follow these steps :

Step 1. Select the Colors option. e

PERSONALIZATION

Step 2. To set window accent colour, set the -
Automatically pick an accent color we-
from background option to Off and -
choose a colour.

Step 3. To set a colour for start menu,
taskbar and action center, set the
Show color on Start, taskbar, action
center, and the title bar option to On
and choose a colour.

Step 4. To make the start menu and taskbar transparent, set the Make Start,
taskbar, and action center transparent option to On.
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PERSONALZATION

Choose a color

Autcematically pick an sccen color fram my Sckground
Show color on Stark. taskbar, action center. and title bar
@ on

Make STarL Raskbar, and action censer Traesparent

& on

Fact KnOW . Local Knowledge

Action Center icon is located on the right-hand side of the Windows taskbar in the notification area.
In Windows 10, Action Center is where you will find your app notifications.

CUSTOMIZING THE WINDOWS 10 LOCK SCREEN

Lock screen is the screen that appears at the time of Windows start up and
when you don’t work on the system for some time. The Lock screen will always
show the time and date while it sits there waiting for us to click on it to log in,
but we can do so much more with it too. We can customise the appearance of
the Lock screen. We cannot only change the picture displayed, but also show
information from some apps. Changing the lock screen image is just as simple
as changing the background. s

B

To change the Windows 10 lock screen, open the = =
PERSONALIZATION window and follow these - o O

steps :
Select the Lock screen option. I
Select the Picture or Slideshow option.

Click on the Browse button and select
the picture.

Choose an app to show a detailed
status and seven other apps to show
quick access.
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CHANGING THE WINDOWS 10 THEME

A theme is a combination of desktop background pictures, window accent
colours and sounds. We can apply a theme if we do not want to make personal
settings for desktop background picture, window accent colours, lock screen,
etc.

To change the Windows 10 theme, open the PERSONALIZATION window and
follow these steps :

Select the Themes : i

Rangeouna

option. il =
Select the  Theme L: R ey iw -
settings option. -
Select the desired ?f’*‘
theme. = 3 H g &
I:a ct KDOW . Local Knowl@

We can also click the link to Get more themes online, which will open our browser and show us
hundreds of user-created themes that we can download to our computer.

Desktop Icon Settings

By default, Windows 10 desktop contains the Recycle Bin icon. In order to place
other icons, open the PERSONALIZATION window and follow these steps :

Select the Themes option.
Select Desktop icon

settings option. @ e o [ [ jpows

. s Themes _w":"; g::',:
Tick and choose the = Ot

icons that you want to . Al S - . A

place on the desktop. *
The  Desktop  Icon

Settings dialog  box

appears.

Click on OK button.

CHANGING THE APPEARANCE OF THE START MENU

To change the appearance of the Start menu, open the PERSONALIZATION
window and follow these steps :
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Select the Start option.

To ensure that the apps or programs that have been used recently are
displayed in the Start menu, set the Show most used apps option On.

To display the Start menu - - v

in full screen, set the Use i{::wm" | ——
Start full screen option -- <.
On, =
Click on CHOOSE WHICH S oo
FOLDERS APPEAR ON e =
START option and choose < ST
the folders to be displayed S =2

in the Start menu.

J&Zaa@@aaﬁ the

©  Thefirst screen that appears after loading the operating system with labelled pictures on it is called Desktop.
©  The picture appears as a background on the desktop is called wallpaper.
D)

A theme is a combination of desktop background pictures, window accent colours and sounds.

A. Tick (v) the correct answer :
1. The picture appears as a background on the desktop is called

(a) Desktop (b) Picture (c) Wallpaper (d) Theme

2.  Which of the following options is not present in the PERSONALIZATION
window?
(a) Picture (b) Background { ) (c) Themes (d) Colors

3. is the latest version of MS Windows.

(a) Windows 7 (b) Windows 8 (c) Windows 107 ) (d) Windows 11
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5.

Where does the Action Center located?

(a) Left side of the taskbar (b) Right side of the taskbar

(c) Middle of the taskbar (d) None of these

Which of the following options is not a type of background?

(a) Picture (b) Screenshot (c) Solid color (d) Slideshow

B. Write ‘T’ for true and ‘F’ for false in the given circles :

1
2
3.
4
5

By default, Windows 10 will use a dark grey Start menu.

We cannot customize the appearance of the Lock screen.

The desktop consists of icons and taskbar.

By default, Windows 10 desktop contains the Recycle Bin icon.
We cannot change the wallpaper of our desktop.

C. Fill in the blanks :

L.
2.

3.

4.

5.

By default, the taskbar of the Windows 10 is in colour.

is the screen that appears at the time of Windows start up and
when we don’t work on the system for some time.

The first screen that appears after loading the operating system with labelled
pictures on it is called

A is a combination of desktop background pictures, window
accent colours and sounds.

is where we will find our app notifications.

D. Answer the following questions :

1. What is a Lock screen?
2. What are the different ways of opening the PERSONALIZATION window in
Windows 107
3.  What is a theme? Write the steps of changing the theme.
4.  How can you change the appearance of the Start menu in Windows 107
5. What is wallpaper?
Creativity Skills [ dl| Ao Integrition

Draw and colour the icons of Windows 7 and Windows 10 in your notebook.

Visit your computer lab and perform the following tasks :
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Set the desktop background.

Change the colour scheme used throughout Windows 10.
Customize the Windows 10 lock screen.

Change the Windows 10 theme.

Change the appearance of the Start menu.

o W=

Experience-based Questions Higher Order Thinking Skills

1. Akash wants to display the Calendar and ...
time on the Lock Screen. What steps should /===
he follow to complete his task? s

Themay

2. Observe the given figure and answer the -
following questions :

(a) Name the figure. R
(b)  For what purpose this window is used? h
(c) Name the options present in the fime]
Background drop-down menu. =
Think & Answer Life Skills & Values

If your friend has Windows 7 on his computer and he needs to work with some of the
features of Windows 10 then what will you do to help him?

Activity Work Cutting & Making Skills

Prepare a chart on ‘Different versions of Windows operating system’.

o —

‘DiSCUSSiOI"\ Communication

Discuss the different features of Windows 10 in class in detail.

Teacher's Help
© The teacher should give enough practice to the students on how to customize the appearance of computer in

Windows 10.
, 2.
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Alphabet Coding

Form a word using the given letters, and tick (/) the category which it belongs to. One
has been done for you.

1.

RIDAYF FRIDAY
(a) Bird

TWIENR

(a) Season

TOSUL

(a) Season
SIJENAM

(a) Vegetable
LABKC

(a) Animal
RESARE

(a) Sport

VAUGA

(a) Vegetable
BAIRTB

(a) Measuring Unit
RCOKF

(a) Sport

(b) Day v

(b) Vehicle

(b) Flower

(b) Tree

(b) Colour

(b) Furniture

(b) Fruit

(b) Utensil

(c) Month

(c) Water animal

(c) Animal

(c) Fruit

(c) Fruit

(c) Dress

(c) Tree

(c) Stationery item

(b) Kitchen tool (c) Beverage
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(d) Year

(d) Food item

(d) Vehicle

(d) Flower

(d) Body part

(d) Stationery

(d) River

(d) Animal

(d) Dress
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Editing in MS Word 2019

LEARNING [0]8)e{e] !X

In this chapter, you will learn about :

O  Selecting the Text © Inserting the Text
©  Moving the Text ©  Copying the Text
©  Undo and Redo Options ©  Find and Replace
©  Spelling and Grammar ©  Thesaurus

Making changes after typing the text in a document is called editing. We edit a
document to insert text, copy text, delete text, move text or rectify errors. To
perform the actions like copying, moving or deleting the text, we need to select
the text first.

SELECTING THE TEXT
We can select the text using the mouse or the keyboard.

Selecting the Text Using the Mouse
Various methods of selecting the text using the mouse are :

A word Double-click on the word.

A sentence Move the pointer to the left of the line. When the
cursor’s shape changes to a right-pointing arrow, click it.

A paragraph Triple-click anywhere in the paragraph or double-click to

the left of the paragraph, when the shape of the cursor
changes to a right-pointing arrow.

Entire document  Triple-click to the top-left of the document text, when the
shape of the cursor changes to a right-pointing arrow.

Selecting the Text Using the Keyboard
Various methods of selecting the text using the keyboard are :
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One character to the right Ctrl + —»

One character to the left Ctrl + «—

One word to the right Ctrl + Shift + —>
One word to the left Ctrl + Shift +<+—
Text from the current position to the beginning of Ctrl + Home

a line

Text from the current position to the end of a line Ctrl + End

Text from the current position to the end of a Ctrl + Shift +
paragraph

Text from the current position to the beginning of a Ctrl + Shift +4
paragraph

The entire document Ctrl + A

INSERTING THE TEXT
We can insert new text to an already existing document.

Step 1. Place the cursor where you want to insert the text.
Step 2. Now start typing the text.

H o L Em -

.....

DO GOOD GOOD) DO GOOD GET|GOOD.

i ¥
Pagetolt  Nworss (5 fnghh Usmd maen (i hconsiity doodne go OB R -———— wm Pageial!  aworss (5 Engeshtusaed Suten)  (paccesitiny Geod 1o go o B & -———4—- um

The existing text which is placed after the cursor will be shifted to the right
side and the new text will be inserted.

MOVING THE TEXT

The Cut and Paste commands are used to move the text from its original
location to a new location. The Cut command removes the text from its original
location and the Paste command inserts the cut text at the new location.
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To move the text, follow these steps :
Step 1.

HalbCeDd AaBbCeDd AgBb(

Select the text that you want to — (v orr o e O

Clgbuwdt = hort s Faragragh = L

move.
Click on Cut option

Video provides a powerful way to help you prove your point.
When you elick Online Vides, you can paste in the embed code
for the video you want to add. You can also type a keyword to
search online for the video that best fits your document.

Step 2. in the

Clipboard group on the Home tab.

The text disappears from the -
document. Place the cursor at the ~
location where you want to place the cut text.

Click on the Paste optlon in the Cllpboard group on the Home tab

Step 3.

Step 4.

AsBbCchd| MaBbleDd ASRDC;

Ly . ¥ on T 8 it : 2
».&-n- &K ' I o ! 1 ¥ - w. A-na- &K

Cipbsad = o £ Parsgran L] e = Cighourd % P " Tur g = e

AaBibCchd | AsBbCcld AZRBIC

‘When you click Online Video, you can paste in the embed code

When you click Online Video, you can paste in the embed code for the video you want to add. You can also type a keyword to

for the video you want to add. You can also type a keyword to
search online for the video that best fits your document.

Accesbiny; Gord 1 g

search online for the video that best fits your document.
Video provides a powerful way to help you prove your point.

e e— ]

~ Local Knowledge

FactKhOW

We can press the Ctrl + X key combination to cut the selected text.

COPYING THE TEXT

The Copy and Paste commands are used to duplicate the text. We can copy the
text from one location to another within a document or even from one document
to another. This feature helps in reducing our time and effort in typing.

To copy the text, follow these steps :
Step 1. Select the text that you want to copy.

Step 2. Click on Copy option in the Clipboard group on the Home tab.
Place the cursor at the location where you want to copy the text.

Step 3.

- o Bty e T . ¥ AuBbCcDd| Magbcend Aafibi
[ LEE A e =g YoR Editing Pty - = ==y Yo Eatiting
¥- A d A
Chbowd = wort Faragrach = s Clgbowrd. Fart Faragragh = e
P T N BT e B I : 7

Video provides a powerful way to help you prove your point. When Video provides a powerful way to help you prove your point. When
wou click Online Video, you can paste in the embed code for the video you click Online Vides, you can paste in the embed code for the video
you want to add. You can also type a keyword to search online for the you want to-add. You can also type a keyword to search online for the
video that best fits your document. video that best fits your document.

Page 1 o Gpa » R Page 1t o G o ——
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AaBbCcDd | AaBbCeDd AaBbCy

Step 4. Click on the Paste option = ™ oo s ™0 ouhin on o s
. . : Video provides a powerful way to help you prove your point. When
: u click Online Video, you can paste in the embed code for the video
I n the Cl I pboa rd grou p On 1 ::uwantto add. \"ouc::a]sut:peta keyword to search online for the
th e H O m e ta b ] et vildeo that l.:rest fits your document.

Video provides a powerful way to help you prove your point. When
you click Online Video, you can paste in the embed code for the video
you want to add. You can also type a keyword to search online for the
video that best fits your document.

Page it of 1 82 words 4 Enghsh ‘Unded States 3y Accesaibivty: Good 10 go 7: ==} R —p
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Fact KhOW . Local Knowledge

We can press the Ctrl + V to paste the cut/ copied text.

UNDO AND REDO OPTIONS

MS Word keeps track of all the changes that we make in a document. We can easily
undo the change and restore the original text. The Undo and Redo buttons
are available on the Quick Access Toolbar

The Undo command is used to reverse the last action performed, while the
Redo command is used to reverse the effect of the Undo command.

Fa CtKnOW . Local Knowledge

Ctrl + Z and Ctrl + Y are the shortcut keys for Undo and Redo commands respectively.

FIND AND REPLACE

When we're working with longer documents, it can be difficult and time
consuming to search for a particular word or text in a document. Word can
automatically locate a specific word or text in a document using the Find
feature, and it allows us to quickly change a specific word or text in a
document using Replace option.

Gt (Bosy 0 | A ke B BH R Y Luncios mmeioe AaBhCi AsBbicl

Finding Text e R B D = e
To find a word or text in a document, | eyl ol ol

To make your document ook professionally pi mlued Ward provides
Pealer, foater . caver nm and teat box designs tha wummw
0, You can #dd 3 matching coves page, header, and
and then choose the clements \-uwmnmnm

follow these steps :

Step 1. Click on the Find option in
the Editing group on the
Home tab.
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Step 2. Type the word that you want to find in the Search Document box.
Step 3. Now, click on a result in the Navigation pane to see it in the

Document1 - Word Sign in (53]
Insert Draw  Design  Layout References  Mailings Review View  Help @ Tell me what you want to do
TR ¢ . T e oo it O Find -~
| { = = - Mg e e = 3= 8 T =
y o | [Calibri (Body) 15 AN A- @ =iz~ &8 LT | asebcedd| AsBbCcdd AaBbC( AaBbCel % s

— - S Replace
pafte = B T U ~ ae x 3¢ B~ % . A 0 = = == :; - ., T T Normal | % NoSpac.. Heading1 Heading2 = [+ Selact ~
Clipboard = Font = Paragraph s Styles = Editing o
N x %, L (L0 T T S TSR A S TR TR B DA N, S TN . SO R I T R I S [ LR S RS P DR R TR T TS LI oo o

avigation b Rox " A
g Video provides a powerful way to help you prove your point. When you

viDed) x - click Online Video, you can paste in the embed code for the video you want
- to add. You can also type a keyword to search online for the video that best

b / fits your document.
Headings Pages Results ] p <

: To make your document look professionally produced, Word provides
Video provides a powerful way to help you prove your 5 header, footer, cover page, and text box designs that complement each
R AT A T S = other. For example, you can add a matching cover page, header, and
you prove your point. When you click Online Video, - sidebar. Click Insert and then choose the elements you want from the
you can paste in the embed code for the = different galleries

, you can paste in the embed code for the video you

il s A e b e ot it fsoid Themes and styles also help keep your document coordinated. When you

.,; click Design and choose a new Theme, the pictures, charts, and SmartArt
graphics change to match your new theme. When you apply styles, your
headings change to match the new theme.

also type a keyword to search online for the video that
best fits your document. o

2 Save time in Word with new buttons that show up where you need them.
3 To change the way a picture fits in your document, click it and a button for
5 layout options appears next to it. When you work on a table, click where
you want to add a row or a column, and then click the plus sign.

"
-

Pagelof 1 1of 194words (4  English (United States) (33 Accessibility: Good to go EE =2 B -—h—+ 5%

We can look at all the results by clicking on the Next Search Result and
Previous Search Result arrows in the Navigation Pane.

*—

Fact KDOW . Local Knowledge

When we are finished, click the [X] to close the navigation pane. The highlight will disappear.

Replacing the Text

The Find and Replace commands can be combined to find a particular word or
text in a document and replace it with another word or text.

To find and replace text, follow these steps :
Step 1. Click on the Replace option in the Editing group on the Home tab.,
Step 2. Enter the text you want to search and replace in the Find what: box.

Step 3. Enter the new text to replace the existing text in the Replace with:
box.

Step 4. Click Find Next.

\ 13,
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Step 5. Click on the Replace to change individual instances of text or Replace
All to replace every instance of the text throughout the document.

Cpboard T Ve 1 Faagragh x e fetng

Video provides a powerful way to help you prove your point. h'vhcn you
1 ®

e T =
P oy e et E———— L g G R Meleg Redew Vw1 + I T ——
graphics change to match your new theme. When you apply styles, you e o=
headings change to match the new theme. —~ S Papiace
. . L | A Select
Save lirme in Word with new buttions that show up where you nieed then i _—
To change the way a picture fits in your document, dick it and a button fg ¥ = ear - Lo i Lor: |
layout options appears next to it. When you work on a table, dlick whet ~ g _ ! '
you want to add a row or 3 column, and then click the plus sign Video provides a powerful way to help you prove your point, When you
Page 1l 1 184 mords Erghed Lirded Jaber Ly bicorsbiy. Sood e go click Online Video, you can pasie in the embed code for Ehe video you want
to add, ¥ Is0 type 3 keyword to hanline for the video that best
fit uruse sarmant
and Regtace
S
e i vden
Optars  Yeawch Down
o ool
e Eeviare Resiae 1 e Canow
Save time in Word with new buttons that show up wheve you need them.
To change the way a picture fits in your document, click it and a button for
layout optians appears next to it, When you wark on a tabile, click where
st 3t 4 3 2 roaw rr 3 erdeimn and Hhan click the i sion
fage 1 # e —
K

We can press the Ctrl + F keys to find the text and Ctrl + H keys to replace the text.

SPELLING AND GRAMMAR

MS Word provides us with several proofing features—including the Spelling
and Grammar tool that can help us produce error-free documents. For each
error in our document, Word will try to offer one or more suggestions. We
might have noticed that when we are typing some text in Word 2019, we get
red or blue wavy lines under some words.

@ A red wavy underline indicates a misspelled word. Any word that is not
there in the Word dictionary is marked as misspelled.

© A blue wavy line indicates grammatical mistakes, including misused
words (also known as a contextual spelling error, occurs when a word is
spelled correctly but used incorrectly).

To check spelling and grammar, follow these steps :
Step 1. Click on the Spelling & Grammar option in the Proofing group on the

Review tab.
, 2.
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Step 2. The Spelling and Grammar pane will appear. You can select a
suggestion and click Change to correct each error.

Step 3. Click on the OK button.

T . : e
L Thesana A @ Ik Cornient > 5
" [P ek unguige Mew — Tracking | Acorpt Compars PO e
::' - it ol A Comrvnens | St Comiments ey i e
rrrrr o] Spea  scenmim Comtrrants Changes carpars
- Proofing
Video provides 5 powerful way to help you prove your poinl. When you Spaling
click Cnbine Video, you can paste in the embed code for the video you want et
to add. You can also type a keyword to search online for the video that best
Chick et and the cRoose the eiements you want
fits your decument, o she Bl garery s

To make your document look professionally produced, Word provides
header, footer, cover page, and text box designs that complement each
other. For example, you can add a matching cover page, header, and
sidebar. Click Insert and then choose the elements you want from the
differet gatlery.

Themes and styles also help keep your document coondinated. When you

click Design and choose 3 new Theme, the pictures, charts, and Smartart

3 graphics change to match your new theme. When you apply styles, your
: headings change to match the new theme,
% o ! id) idh wer hel paint,
Save time in Word with new buttons that show up where you need them. LSO RO B Bl way e hedp yoo rowe o € When yon
5 i «lick Online Video, you can paste in the embed code for the video you want
f Ta change the way a picture fits in your document, click it and a button for - =
. . Ignene Mt to add, You can also type 2 keyword to search online for the video that best
1 layout options appears next to it. When you work on a table, click where T fit a ok
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« o e e matching cover page, header, and
5 the elements you want from the

Themes and styles also help keep your document coofdinated. When you
lick Diesign and choose a new Theme, the pictures, charts, and SmartArt
\graphics change to match your new thema. When you apply styles, your
headitgs change ta match the new theme,

Save time in Word with new buttons that show up where you need them.
To change the way a plcture fits in your document, click it and a button for
layout oplicns appears next 1o L When you work on a table, dick whare
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I:a ct IGIIOW . Local Knowledge

Right-click the underlined word or phrase. A menu will appear. Then, select the correct spelling or
phrase from the list of suggestions.

You can press the F7 key to check the Spelling and Grammar in your document.

THESAURUS

MS Word has an in-built dictionary called Thesaurus. This feature provides a
list of synonyms (i.e., words with similar meaning) for a given word and
antonym (i.e., opposite of a word). It proves to be useful by helping us improve
our vocabulary and can be used to replace a word with one of its synonyms.

To use the Thesaurus, follow these steps : FEEEEEG-

Step 1. Place the cursor anywhere === = .2 ~ = s == ===

within the word for which you et S ot o st

£an alsa bype a keymend bo sessch aniine her the viden that best

want to look for a synonym. : e e

over page, dad test bow designa That complement pach

., you <an 300 3 Matching cover page, header, sl
sidderhar Click: inser them choose fhwe slements you want fom the

Step 2. Click on the Thesaurus option in Pt

Themes and styles aiss heln keen your docement coondinated. When you
ek Diesigm and chocss 3 new Thesne, the pictures, charls, and Smartart

the Proofing group on the TSI

Review tab.
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A list of synonyms (and antonyms, if any) appears in Thesaurus pane
on the right side of the window. To use one of the words from the list,
point to it. Then, click on the down arrow next to it and select the
Insert option.

Click on the Insert option.

I:a CtIGnOW . Local Knowledge

We can press the Shift + F7 keys to use the Thesaurus.

@@coe&ct the G

Maklng changes after typing the text in a document is called editing. We edit a document to insert text, copy
text, delete text, move text or rectify errors.

®  The Cut and Paste commands are used to move the text from its original location to a new location.
©  The Copy and Paste commands are used to duplicate the text.

© The Undo command is used to reverse the last action performed, while the Redo command is used to
reverse the effect of the Undo command.

©  Word can automatically locate a specific word or text in a document using the Find feature, and it allows us
to quickly change a specific word or text in a document using Replace option.

©  Word provides us with several proofing features—including the Spelling and Grammar tool that can help you
produce error-free documents.

©  Word has an in-built dictionary called Thesaurus. This feature provides a list of synonyms (i.e., words with
similar meaning) for a given word and antonym (i.e., opposite of a word).

A. Tick (V) the correct answer :
1. The Copy option is present in the group.
(a) Clipboard (b) Proofing (c) Editing (d) Font

. K o
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2. Where is Undo option present?

(a) Font tab (b) Home tab
(c) Quick Access Toolbar (d) None of these
3. To select the text from the current position to the end of a line, press
keys.
(a) Ctrl + Shift + End (b) Shift + End
(c) End (d) Ctrl + End
4, Press the key to check the Spelling and Grammar in your
document.
(a) F5 (b) F6 (c) F7 (d) F8
5. The Spelling & Grammar tool is present on the tab.
(a) File (b) Home (c) Review (d) Insert

B. Write ‘T’ for true and ‘F’ for false in the given circles :
1 The Copy and Paste commands are used to duplicate the text.
2 A blue wavy line indicates grammatical mistakes, including misused words.
3.  To select the entire document, press Ctrl + E key combination.
4 Thesaurus provides a list of synonyms and antonyms.
5 The Find option is used to locate a specific word or text in a document.

C. Fill in the blanks :

The command is used to reverse the last action performed.
Making changes after typing the text in a document is called

Word has an in-built dictionary called :

Ctrl + X is the shortcut key for option.

A wavy underline indicates a misspelled word.

o s W=

D. Answer the following questions :

What do you mean by editing?

What are the uses of Copy and Paste options?

What is the difference between Undo and Redo options?
What is the use of Spelling & Grammar option?

What is the use of Thesaurus option in Word 2019?

o R W=

;reaﬁvify Ski"S i ﬂ Art Integr&ti?

Draw and colour the logo of MS Word 2019 in your notebook.
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Open MS Word 2019 and type the given text. Then, edit the text according to the given
instructions :

© Move the first paragraph after the second paragraph.

© Then, read the story.

) Now, search the word ‘Frog’ and replace it with ‘Cat’ in the whole document.

© Correct all the incorrect spellings using Spelling & Grammar option.

) Save the file with the name ‘Story’.

The Frogs' Race

Little by little, the frogs felt disapointed and discouraged, except for one of them that continued
to run. And everybody cried out : “Give up! Give up! You'll never get to the top!” Listening
repeatedly to these negative words led the frogs to abandon the race after all, except for the one
frog that, despite what people were saying, and though alone and with great pain, continued to
run and finally reached the top.
One day, a group of frogs decided to make a racce and get to the top of a high tower. A loot of
people came to see them and give them their support, but the race had just begun and
everybody was already saying that the frogs would not get there: “It doesn't make any sense
going on! You'll never reach the top of the tower!”

Think & Answer Life Skills & Values \

Your friend is unable to move the text from one place to another after trying many times.
What will you do? Justify your answer.

_HCHVitH Work Cutting & Making Skills

Prepare a chart on ‘Selecting text in MS Word 2019'.

[ S

‘DiSCUSSiOI’\ Communication

Divide the class into two groups and conduct a group discussion on ‘Editing Text in MS
Word 2019'.

Teacher's Help
© The teacher should ensure that the students are comfortable using both mouse actions and keyboard shortcuts
for simple commands like Cut, Copy, Paste, etc.

\ 13,
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Formatting in MS Word 2019
LEARNING

In this chapter, you will learn about :

©  Character Formatting ©  Paragraph Formatting
©  Bullets and Numbering ©  Applying Borders

The process of changing the appearance and arrangement of text to make it
look attractive is known as formatting. Formatted text can draw the reader’s
attention to specific parts of a document and emphasize important information.

CHARACTER FORMATTING

The process of displaying Tncrease Font Size o ooce Font Size

the selected text in a

certain manner is called sz " | > Change Case
character formatting. It

| - -
Font «—|Calibri Body)  -[11 -| A A Aa~ A —>clear All Formatting

consists of text properties _
like bold, italic, underline, ~ BB [ U - B 50 A —font Color

font style, font colour, font Uhd“:f"“—l \ Font L 5

size, etc. Text Highlight Color
In class 3, we have strikethrough Text Effects
al ready learnt how to Subscript «—  L»Superscript

change the font style,
colour and size. Let us now look at some more formatting options available in
the Font group.

Increase Or Decrease Font Size

The Increase Font Size and Decrease Font Size options are used to make your
text a bit bigger and smaller respectively. To increase or decrease font size,

follow the given steps :
\ 13,
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Select the text.

Click on the Increase Font Size to make the text bigger and Decrease
Font Size to make the text smaller in the Font group on the Home tab.

Fact W Know

Lo

AsBinCcld | AaBbCrDd t

Good Morning

[

~ Local Knowledge

We can press the Ctrl + > keys for Increase Font Size and Ctrl + < for Decrease Font Size options.

Changing the Case

When we need to quickly change text case, we can use the Change Case
command instead of deleting and retyping text. Word 2019 allows us to
change the case of typed text to any of the following five options :

Sentence case

lowercase
UPPERCASE

Capitalize Each Word

tOGGLE cASE

Only the first letter of a sentence is
displayed in uppercase. The rest of the
letters are displayed in lowercase.

All the letters are displayed in small

letters (lowercase). By | =-E-
All the letters are displayed in capital | St
letters (uppercase). UpPERCASE

The first letter of each word is displayed fmrt, ”

in uppercase. The rest of the letters are
displayed in lowercase.

It changes the case of every letter. The
uppercase letters are changed to
lowercase and the lowercase letters are
changed to uppercase.

To change the case of the text, follow the given steps :
Select the text.
Click on the Change Case option in the Font group on the Home tab.
Select the desired option.
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Say please. This shows consideration for others.

Say thank you. This demonstrates appreciation and
gratitude.

Look people in the eye when you speak to them. ...

Smile & have a good attitude. . Say please. This shows consideration for others.

say thank you. this demonsftrates appreciation and

Say excuse me. gratitude.
LOOK PEOPLE IN THE EYE WHEN YOU SPEAK TO
THEM. ...
i Teia e A S - Smile & Have A Good Attitude. ...
sAY EXCUSE ME.

Mg iet Mven [re—— Y dcoeniatng. Gosdts g

Bold, Italic and Underline

The Bold, Italic or Underline options can be used to emphasize the text to
make it stand out. These options can be used to help draw attention to
Important words or phrases.

To apply the Bold, Italic or Underline effect to the text, follow these steps :
Step 1. Select the text.

Step 2. Click on the Bold option to bold the text, Italic option to italicize the
text and Underline option to underline the text in the Font group on
the Home tab.

T mabecond. Aspbcond Bl

T samecend sabscedd AGRHCH | S

Always think before you act and speak.
Don't forget to love yourself every day!
It's never wrong to ask for help. 3 Always think before you act and speak.
Don't forget to love yourself every day!
It's never wrong to ask for help.

[ " g s, e . el 13 = B .

o—

Fact KDOW _ Local Knowledge

We can press the Ctrl + B for Bold, Ctrl + | for Italic and Ctrl + U keys for Underline options.

The Bold & , Italic r and Underline v buttons have two states — On and Off.
When the buttons are in the ‘On’ state, the required style is applied on the
text. When the buttons are in the ‘Off’ state, the required style is removed

from the selected text.
\ 13
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Strikethrough, Superscript and Subscript

Strikethrough is a font effect that cross something out by drawing a line
through it.

To apply Strikethrough, follow these steps :
Step 1. Select the text.

Step 2. Click on the Strikethrough in the Font group on the Home tab.
It cross the text out by drawing a line through it.

...................................

Don't be afraid of making mistakes, Den-tbe-afraid-of-making-mistakes;
learn from them and grow! learn-from-them-and-grow!

te e g b Do e = - ] - o e o e aumntts Socd s g4 —

Superscript refers to the text that is positioned slightly higher than the line of
text. To apply Superscript, follow these steps :

Step 1. Select the text.

Step 2. Click on the Superscript in the Font group on the Home tab. It
positions the selected text slightly higher than the line of the text.

o i Em

saoacina nasncsos AGBOCI Ast i T S SO EE T [ aniios

. Regiaen

| study in class 4th. | study in class 4™,

gt | Bagith e g ey ead 1 g e C— -

Subscript refers to the text that is positioned slightly lower than the line of text.
To apply Subscript, follow these steps :

Step 1. Select the text.
Step 2. Click on the Subscript in the Font group on the Home tab.
It positions the selected text slightly lower than the line of the text.
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Text Effects

We can modify the appearance of the text by changing the fill or outline colour
and adding effects like shadow, glow, reflection effects, etc. using the Text
effects option.

To apply text effects, follow these steps :
Step 1. Select the text.

Step 2. Click on the Text Effects and Typography option in the Font group on
the Home tab.

Step 3. Select the desired option.
It changes the appearance of the text.

T maBeCeDd| AsbbCeDd A 3EID k sl |

Har | -eynote of success. ;_ Hard work is the keynote of success.

Clear All Formatting

We can easily clear all formatting (such as bold, underline, italic, colour,
superscript, subscript, and more) from our text and return our text to its default
formatting styles. The Clear All Formatting option is used to remove all
formatting from the selection, leaving only the normal, unformatted text.

To use the Clear All Formatting option, follow these steps :

Step 1. Select the text.
\ 13,
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Step 2. Click on the Clear All Formatting option in the Font group on the
Home tab.

It clears all the formatting.

Hard work is the keynote of suc:essl

Highlighting Text

Highlighting means making the text look different to draw the reader’s attention
towards it. We can highlight important parts using the Text Highlight Color
option.

To highlight the text, follow these steps :

Step 1. Select the text.

Step 2. Click on the Text Highlight Color option in the Font group on the
Home tab.

" [hetorchd Mabccod AABDCI AaBbCel | 4
' Uo- o o - EELA = E e I .

i v AEEE '
% acrmaine 'EEEEE Cotmow s
I_ll |
Hard work is the keynote of success.
Hard work is the keynote of success!
—
Fact Wl Kinow Looal Knowledge

If you want to remove highlighting then select No Color option from the drop-down menu of Text
Highlight Color option in the Font group on the Home tab.
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Character Formatting Using the Font Dialog Box

We can use the more formatting options using the Font dialog box. To open the
Font dialog box, click on the Font dialog box launcher in the Font group on the
Home tab.

Select Font style

Select Font size

Select Underline

~
adings
erian old Italic
|rial ¥ L2 sl
ont color: ndlerfine style: srraerling color
Automatic |~ |  (none) ~ | Select Underline
Effects colour

Select colour

/ i g ¢

q Strikethrough Small caps
Select special L] strgetheoug [ smalt cap
D Double strikethrough D All caps
effects il |:| Superscript D Hidden
|:| Supscript
Preview
+Body
|
This is the body theme font. The current document theme defines which font will be used.
Set As Default Text Effects... Cancel

PARAGRAPH FORMATTING

The paragraph formatting feature of Word 2019 can be used to format the
appearance of text in a paragraph.

Aligning Text

The manner in which text is placed between the margins of a page is called
alignment. Word 2019 allows us to change the alignment of the text to any of
the following four options :

Align Left It places the text towards the left margin leaving a
ragged right edge. By default, the text is always aligned
to the left margin.

Center _ It places the text in the centre of the left and right
~ margins.
Align Right It places the text towards the right margin leaving a

ragged left edge.
Justify

It places the text evenly between the left and right margin.
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To align the text, follow these steps :
Step 1. Select the text.

Step 2. Select the required Alignment options in the Paragraph group on the
Home tab.

Caitr hody W & a5 N " *
Video provides a powerful way to help you prove your point. When you click T = v A P . vt [ 1 it et
Online Video, you can paste in the embed code for the video you want to add.

. Jse— -
You can also type a keyword to search online for the video that best fits your L

document. To make your document look 9”““'”‘"!‘!' produced, Word Video provides a powerful way to help you prove your point. When you click
provides header, footer, cover page, and text box designs that complement Online Video, you can paste in the embed code for the video you want to add,

each other.
You can also type a keyword to search online for the video that best fits your
For example, you can add @ matching cover page, header, and sidebar. Click document, To make your d look prafessionally 4 Word

Insert and then choose the elements you want from the different galleries. provides header, footer, cover page, and text box designs that complement
Themes and styles also help keep your document coordinated. When you chick - each other,

Design and choose a new Theme, the plctures, charts, and SmartArt graphics For example, you can add a matching cover page, header, and sidebar. Click
change to match your new theme.

Insert and then choose the elements you want from the different galleries,
Themes and styles also help keep your document coordinated. When you click

Design and choose a new Theme, the pictures, charts, and SmartArt graphics
change to match your new theme.

et R g v S, (3 o Gizthe g R S——
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We can press the Ctrl + L for left, Ctrl + E for center, Ctrl + R for right and Ctrl + J for justify
alignment.

Line Spacing

The amount of blank space left between the lines of text in a paragraph is
called line spacing. It is measured in lines or units called points.

To increase or decrease the space between the lines, follow these steps :

Step 1. Select the text.

Step 2. Click on the Line and Paragraph Spacing option in the Paragraph
group on the Home tab.
Select the desired spacing value.

Step 3.

B0¥ | asonceoe| sasnccne AafibCi sabt

"' | astncod | aesnceDa ASELCE AsBbC

| Ovman 5 - . e ; - T ey
| Video provides a powerful Way . «.ep yo= pree= y=<f paint. When you click
1 Online Video, you can paste in the embed code for the video you want to add.
1 You can also type a keyword to search online for the video that best fits your
i document.
To make your d look professignall 4, Word pi header, Video provides a powerful way to help you prove your point, When you click

footer, cover page, and text box designs that complement each other. For .
example, you can add a matching cover page, header, and sidebar. Click Insert Online Video, you can in the embed code for the video you want to add.

and then choase the elements you want from the different galleries. You can also type a keyword o search online for the video that best fits your

(oot cvmemn [ oo & s sty MRS -—— || dosurmant.
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Paragraph Spacing
The amount of blank space above or below a paragraph is called paragraph
spacing. To set the paragraph spacing, follow these steps :

Select the text.

Click on the Layout tab.

Specify the required values in the Before: and After: spin boxes in the
Paragraph group.

| aapecee assoccod A8

Video provides a powerful way to help you prove your point. When you click
Online Video, you can paste In the embed code for the video you want to add.
You can also type a keyword to search online for the video that best fits your

document. Video provides a powerful way to help you prove your point. When you click
Online Video, you can paste in the embed code for the video you want to add.

d | riife ol A d ;
Tomake your ok p Woee 9 haader You can also type a keyword to search online for the video that best fits your

footer, cover page, and text box designs that complement each other. For
example, you can add a matching cover page, header, and sidebar. Click Insert
and then choose the elements you want from the different galleries.

document.

To make your document look professionally produced, Word provides header,
footer, cover page, and text box designs that complement each other. For
example, you can add a matching cover page, header, and sidebar. Click Insert
SN 5 g~ S M- S N 1

- il i =
Ngpiall v st o e, iy sy bose s g0 R

- + e

Indenting Text

The amount of spacing between the text and the page margins is called
indentation. Various types of indentations are as follows :

Left Indentation It is used to specify the amount of spacing to be given
from the left margin.

Right Indentation It is used to specify the amount of spacing to be given
from the right margin.

Special Indents They are divided into two parts :

First Line It makes the first line of the paragraph
indented more towards the right, compared to
the subsequent lines.

Hanging It makes the first line of the paragraph
indented more towards the left, compared to
the subsequent lines.

To set the indentation for the text, follow these steps :
Select the text.
Click on the Layout tab.

\ 13,
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Step 3. Specify the required values in the Left and Right spin boxes in the
Paragraph group.

| Paragraph

Paragraph Formatting Using the Paragraph Dialog Box

We can apply the paragraph formatting using the
Paragraph dialog box. To open the Paragraph dialog
box, do one of the following :

@  Click on the Paragraph dialog box launcher in the
Paragraph group on the Home tab.

Or

@  Click on the Paragraph dialog box launcher in the
Paragraph group on the Layout tab.

BULLETS AND NUMBERING

It is an important feature of Word 2019. It is useful when we want to present
our text as a list of items. Lists make it easy to find information that you are
looking for.

There are two types of lists.
© Bulleted list © Numbered list

Bulleted List : A bulleted list is usually used when the order of items in the list
does not matter (unordered). By default, Word uses a simple black dot as a bullet.

Creating a Bulleted List

To create a bulleted list, follows these steps :

Step 1. Select the text.

Step 2. Click on the Bullets option in Paragraph group on the Home tab.
Step 3. Select the desired bullet.

Today is a great day to leam something new.

Every day may not be good. But there is something good in every day.
Yesterday is gone. Tomorrow has not come yet. We have only today. Let us
begin.

You only live once. But if you, do it right, once is enough.

+ Today Is a great day to learn something new.

+ Every day may not be good. But there is something good In every day.

« Yesterday is gone. Tomonrow has not come yet. We have only today.
Let us begin.

« You only live once. But if you, do it right, once is enough)

BTN Wehems e Tpweees L aseiiy Seinps L. - -—



Numbered List : A numbered list is used for listing when the order of items is
Important, e.g. a sequence of events or steps.

Creating a Numbered List

To create a numbered list, follows these steps :

Step 1. Select the text.

Step 2. Click on the Numbering option in Paragraph group on the Home tab.

T maweccos | semscond A3BbC) AaB

Today is a great day fo leamn something new.

Every day may not be good. But there is something good in every day.
Yeslerday is gone. Tomorrow has nol come yet, We have only loday. Let us
begin.

You only live once. But if you, do It right, once is enough.

Fact & Kohow

Step 3. Select the desired numbering style.

T MaBbccbd AsBbchd AaBhO; Ak

1. Today s a great day to leam something new.

2. Every day may not be good. But there is something good in every day.

3. Yesterday is gone. Tomorrow has not come yed, We have only today.
Let us begin,

4. You only live once. But if you, do it ight, once is enough)

=~
[ S—

~ Local Knowledge

We can convert the bulleted list into numbered list by clicking the Numbering option and numbered
list into bulleted list by clicking the Bullets option in the Paragraph group on the Home tab.

APPLYING BORDERS

We can add borders around the text, a paragraph or a page.
To add a border around the text or a paragraph and a page, follow these steps :

Step 1. Select the text.
Step 2. Click on the Borders option in

Paragraph group on the Home T

tab.
Step 3.
option.
Step 4.
under Setting: section.
Step 5.
Style: list box.

Step 6.

Select Borders and Shading...

Select the appropriate option |-

Select the border style under

" | nadoloDs) Asseccos AafL B

Video provides a powerful way to hedp you e you click Online
Video, you can paste in the embed code | nt lo add. You can
also type a keyword to search online for th your document.

To make your docurnent look profession . 4 provides header,

footer, cover page, and lext box designs the other. For example,
you can add a matching cover page, heaw. =70 TIINIET Liick Insert and then
choosa the elemaents you wanl from the different galleries.

Select the border colour under Color: list box.
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Borgers and Shading T h- 4

Step /. Select the border thickness under .. e o

Width: list box. = e | i —
Step 8. To add a border around the page, [I=- : -
click on the Page Border tab. O~ == g
Step 9. Select the appropriate option under - == 8 o
Setting: section. i
Step 10. Select the border style under Style: ——
list box.

Step 11. Select the border colour under Color: list box.
Step 12. Select the border thickness.
Step 13. Click on OK button.

-
- _—
Video _J w— | | — | Oniline
Video, L — ‘ou can
alsol - e 0 ] rent.
|| tmem ;i‘ i Video provides a powerful way o help you prove your point. When you click Online
To o - i sy B0 seader, | Video, you can paste in the embed code for the video you want to add. You can
footer, S lample, | also type a keyword 1o search online for the video that best fits your document.
you cf S . N P
choose the elements you want Irnm the different gallerles. | To make your document look professionally produced, Word provides header,
fooler, cover page, and text box designs that complement each other. For example,
Pogw ottt gt (e Bt docwrnbdy Gad gu —es ] you can add a matching cover page, header, and sidebar. Click Insert and then
1 choose the elements you want from the different galleries.

Jg@co@@act the G

The Increase Font Size and Decrease Font Size options are used to make your text a bit bigger and smaller
respectively.

The Bold, Italic or Underline options can be used to emphasize the text to make it stand out. These options
can be used to help draw attention to important words or phrases.

Strikethrough is a font effect that crosses something out by drawing a line through it.
Highlighting means making the text look different to draw the reader’s attention towards it.
The manner in which text is placed between the margins of a page is called alignment.

The amount of blank space left between the lines of text in a paragraph is called line spacing. It is measured
in lines or units called points.

@(W/){(f(}% MANNER @B

You should save your files and shut down the computer after finishing your work.
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Tick (V) the correct answer :

1. The Strikethrough option is present in the group.
(a) Font (b) Paragraph (c) Editing (d) Clipboard
2. Which of the following options changes the case of every letter?
(a) Upper case { ) (b) Toggle case (c) Sentence case{ ) (d) Lower case
3.  The shortcut keys for Increase Font Size option is :
(a) Ctrl + Shift + < (b) Ctrl + <
(c) Ctrl + Shift + > (d) Ctrl + >
4.  Which option positions the text slightly higher than the text on the base line?
(a) Subscript (b) Superscript (c) Strikethrough (d) None of these
5. Which of the following options is not available on the Home tab?
(a) Bold (b) ltalic (c) Thesaurus (d) Underline

Write ‘T’ for true and ‘F’ for false in the given circles :

1. We can add effects like shadow, glow, reflection, etc. using the Text effects
option.

The amount of blank space above or below a paragraph is called indentation.

3. Subscript refers to the text that is positioned slightly lower than the line of the

N

text.

4, By default, Word uses a blue square as a bullet.

D. If we want to remove highlighting then we should click on Clear All Formatting
option.

Fill in the blanks :

1. is a font effect that crosses something out by drawing a line
through it.

2. Line spacing is measured in lines or units called :
3. The manner in which text is placed between the margins of a page is called

4, A list is used for listing when the order of items is important.
5. By default, the text is always aligned to the margin.

Answer the following questions :
1. Name all the options available in Change Case menu.
2. What do you mean by formatting?
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3.  What is the difference between bulleted list and numbered list?
4.  What is the use of Superscript and Subscript options?
5. What do you mean by alignment? Name all the alignment options.

Open MS Word 2019 and type a text of your choice. Then, format the text beautifully.

Experience-based Questions Higher Order Thinking Skills

| Parngan

1.  Observe the given figure and answer the following questions :
(a) Name the dialog box that is shown in the figure.
(b)  How can you open this dialog box? - =
(c)  Which option has been selected in the Alignment = =
category? -
2. Rohan’s teacher asked him to create a list of his favourite
books in Word 2019. He has created a bulleted list. L = L

(@) Which tab and group has the option for creating a
bulleted list?

(b)  Can she convert the list to a numbered list? If yes, how?

r—

Think & Answer Life Skills & Values

Your teacher gave you a project in MS Word 2019 to format. But, you are not able to
format in accordance to what your teacher asked for. She asks you to format it again. How
will you react in such a situation?

Activity Work Cutting & Making Skills |

Create an attractive and beautiful poster in MS Word 2019 on the topic “Eat Healthy, Stay
healthy” using various formatting features available in MS Word 2019.

*—

_DiSCUSSiOH Communication

Discuss the different options of Change Case button in class.

Teacher's Help
©  Demonstrate to the students how the appearance of a Word document can be improved.
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In this chapter, you will learn about :

How to Start MS PowerPoint 20197
Themes for a Blank Presentation
Inserting a New Slide

Adding a Bulleted List

Closing a Presentation

Running a Presentation

©  Microsoft PowerPoint

Creating a New Presentation
Inserting Text in a Placeholder
Formatting the Text

Saving a Presentation

Opening an Existing Presentation

O © O O ©
O © O O © ©

MICROSOFT POWERPOINT

MS PowerPoint is the part of Microsoft Office package. It is a software used to
create presentations. A presentation includes text, pictures, charts, audio, video
and some animated effects. There are so many softwares used to create
presentations like Microsoft PowerPoint, Open Office Impress, etc. But, the most
common and user-friendly software used to create presentation is MS PowerPoint.

Slides

Slides are the individual pages of a presentation which display one by one on a
screen.

Presentation
A presentation is a collection of slides arranged in
systematic order which display the information on a
particular topic.
HOW TO START MS POWERPOINT 20197
To start MS PowerPoint 2019, follow these steps :
Click on the Start button.
Click on the PowerPoint.

Click on the Blank Presentation to create [
a new presentation.
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Fact KDOW . Local Knowledge

There is no “All apps” option in Windows 10 Anniversary Edition. Instead, all of your installed apps
appear in a list on the left side of the Start menu.

When we open PowerPoint 2019, the Start Screen will appear. From here,
we'll be able to create a new presentation, choose a template, or access our
recently edited presentations.

Microsoft PowerPoint window will appear named Presentationl. The various

parts of PowerPoint 2019 window are as follows :
Tabs Title Bar

1 S Replace
. Siide Seciion ject
File Tab Cigbowd P i Vs ki Sy l
- Ribbon

Slides ’ :
Navigation Click to add title

Pane

}

Placeholders

I

Click to add subtitle

Shoe 1 of Engish ek (1 Acomsibity: Good to g & toten  W@BCo iy ; E i - - i
Status Bar 4—| Commenhts J Slide Pane Zoom Cohtrol Slider

Quick Access Toolbar

It is present at the left-most corner of the PowerPoint window. It contains
frequently-used commands. By default, it shows the Save, Undo and Repeat
commands. We can add other commands depending on your preference.

Title Bar

It is present at the top of the PowerPoint window. It shows the name of the
document followed by the program name. There are five buttons in the right
side of title bar. They are Microsoft PowerPoint Help, Ribbon Display Options,
Minimize, Restore Down/Maximize and Close.

Ribbon
A Ribbon is designed to respond to your current task. It contains multiple tabs

\ 13,
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File, Home, Insert, Design, Transitions, Animations, Slide Show, Review and
View, each with several groups of commands. We will use these tabs to
perform the most common tasks in PowerPoint.

Collapse the Ribbon Button

We can collapse the ribbon if we need to see more of the presentation we are
creating. To collapse the ribbon, click the arrow at the bottom right. When we
click on this button, it will minimize the ribbon, only the tab names get displayed.
Placeholder

It is a dotted rectangular box on a slide that holds text, images, etc.

Dialog Box Launcher

It is the small icon that appears in some groups. If we click on this icon, a
dialog box related to that group opens. It may contain many options that we
can select as per our choice.

Slide Pane

A slide is displayed in the slide pane at the centre of the PowerPoint window.
We can edit a slide in the slide pane.

Slide Navigation Pane

It allows us to view all the slides present in our presentation. The selected slide
will appear in the slide pane to the right. We can add, delete, duplicate and
rearrange slides in the slide navigation pane.

Notes Pane

It provides the space to add notes to the current slide. It is also known as
Speaker’s Notes.

Rulers

The Rulers make easier to adjust our document with precision. If we want, we
can hide the Ruler to create more screen space. There are two rulers Horizontal
ruler and Vertical ruler (present at the top and to the left of the current slide).

Status Bar

It appears at the bottom of the PowerPoint window. It provides information
such as the current slide number and number of slides. It contains the Notes
button, Comments button, View buttons and Zoom Slider.
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(a) Notes : Click the Notes to view the notes in the Notes Pane.

(b)  Comments : It is the area where reviewer may leave comment for any
slide. Click on the Comments to view the comments for the current slide.

(c) Zoom Slider : Itis available for zooming in and out of slide quickly and easily.

(d) View Buttons : It is present to the left of the Zoom slider on the status
bar. You can view the slides using one of the following buttons :

© Normal : It is the default view. This view shows the slide navigation
pane and the selected slide.

® Slide Sorter : It displays miniature form of all the slides in a
presentation.

© Reading View : It hides all the editing tools to make your slides
easier to review.

©  Slide Show : It displays the slides in a presentation one by one on
the screen.

Scroll Bars

By default, the Vertical scroll bar and Horizontal scroll bar are shown. We can
hide scroll bars if we want to display more of the document. Click, hold and
drag scroll bar, depending on what part of the slide we want to see.

CREATING A NEW PRESENTATION
A presentation can be created in the following two ways :
© Using Blank Presentation © Using Templates and Themes

Creating a Blank Presentation
To create a new blank presentation, follow these steps :

Click on the File ErEE— —
tab. The Backstage

view will appear. | | |
Select New option. R e

Click on the Blank
Presentation.

A new blank presentation will appear on the screen. By default, it contains two

placeholders.
\ 13,
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Fact KDOW . Local Knowledge

We can press the Ctrl+N keys to create a new presentation.

Creating a New Presentation Using Templates and Themes
To create a new presentation using Templates and Themes, follow these steps :

Step 1. Click on the File tab. The Backstage
view will appear. S s el i

Step 2. Select New option.

Step 3. Double-click on the theme
template thumbnail you want to use.

Step 4. Click on the Create button.

Click to add title

| Clich to ads il

Nlanar

- = r‘ESign | = : : B ks - ! - b
) TITLE LOREM IPSUM

Fact KhOW _ Local Knowledge

A template is a pre-designed presentation which includes custom formatting and designs.

To use online templates and themes, follow the given steps :
Step 1. Select the category.

Step 2. A gallery of online templates and themes will open. Click on the
desired theme or template

Prwmrtitont - Rwette

New

s e vy T et o e g P

Mt T st om0 bl 17
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Step 3. Click on the Create button.

LABORATORY
DESIGN

THEMES FOR A BLANK PRESENTATION

If you have opened a blank presentation, you will still apply a theme to it.
Follow the given steps :

Step 1. Click on the Design tab.
Step 2. Click on the More button in the Themes group.

Step 3. Right-click on selected theme to view the different ways of applying
the theme and select the required option.

Click to add title

Click to add subtitle

jetolt (3 togheh e [y scversdslit desdts [ e O e — I
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If we simply click on the desired theme then the theme will be applied to the
entire presentation. So, right-click on the theme and select Apply to All Slides
option to apply theme to all slides and Apply to Selected Slides option to
apply it to selected theme.

INSERTING A NEW SLIDE

Whenever we start a new presentation, it will contain one slide with Title Slide
layout by default. We can insert as many slides as we need from a variety of
different layouts.

these steps :

Click on the New
Slide drop-down ==
menu arrow in the Click to add title
Slides group on the . _ ik o 3 s
Home tab. '

Select the desired
slide layout. hanr o i ey ——

*—

Fact KDOW _ Local Knowledge

® To quickly add a slide having the same layout as the selected slide, simply click on top-half of
the New Slide button in the Slides group on the Home tab.

©  We can also press the Ctrl + M keys to insert a new slide.

To change the layout of an existing slide, click on Layout button in the Slides
group on the Home tab and then choose the desired layout from the drop-down
menu that appears.

FORMATTING THE TEXT Layout -

Office Theme

Text formatting options are available in the Font
group on the Home tab.

To apply formatting, follow the given steps :
Select the text.

Click on the Font Color option in the Font
group on the Home tab.

Select the desired colour.

\ 13,
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M@

Title Slide Title and Content  Section Header




+ & o
Easion Bry S pe % [EN = = Shapes Arrange Oisick
Slide = 7 .

Styles - -l - Seect
Cipbosrd & sidd g Themcolo r

' —I —
- Il“lllll

Standard Colon
II .-lll

Drasing L £diing

I‘.llMI’IITEH HI\IIIIWAIIE

CLCKTOADD S!lB‘I"ITll.

Sghin Arstwd WaieE (% Mcriabbey ooa1s ga o WCommwm | B R re—

In the similar way, we can change the font type and size. The & , 1 and
u tools make the text bold, italic and underlined, respectively.

ADDING A BULLETED LIST
To add bullets, follow these steps :

Step 1. Click on the Bullets option under the Paragraph group of the Home
tab.

Step 2. Choose approprlate bullet style.

] 2 fal™
Ieoact dony W - KA W . - P 5 B
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SAVING A PRESENTATION
To save a presentation, follow these steps :
Step 1. Click on the File tab.

Step 2. Click on the Save option.

- i =Em e -

Doouments

nnnnn

COMPUTER HARDWARE

{LICK TO ADD SUBTITLE

Step 3.
Step 4.
Step 5.
Step 6.
Step 7.

Select the Computer option.
Click on the Browse button. The Save As dialog box appears.
Select the location where you want to save your presentation.

Type the file name.
Click on the Save button.

Save As

- r— e e e e e e e —— e e — o A Hige Foden

Fact & Know

®  We can press the Ctrl+S keys to save the file in PowerPoint 2019.
®  The default extension of PowerPoint 2019 is .pptx.
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CLOSING A PRESENTATION

To close a presentation, follow these steps :
Step 1. Click on the File tab.

Step 2. Click on the Close option.

Recent  Pinned

You haven't opened any presentations recently. Click Open to browse for 8 presentation.

PowerPoint 2019 will ask to save the changes, if there are changes in the
presentation that have not been saved. We should close the presentation only
after saving it.

> —

Fact KhOW . Local Knowledge

We can press the Ctrl + W keys to close a presentation.

OPENING AN EXISTING PRESENTATION

To open an existing presentation, follow these steps :

Step 1. Click on the File tab. The Backstage view will appear.
Step 2. Select the Open option.

COMPUTER HARDWARE

CLICK TO ADD SUBTITLE

& riotes Wcemner [ " ——.

'3 acracchn _...m\,. a._.
) Computer-4 o
M@



Open

(m) Home

Presentation5 - PowerPoint Signin & ? - O X

“
5 New CL,J\ Recent

Presentations  Folders

. OneDrive

&[ This PC

—+ Add aPlace

B Browse

Account

More..

You haven't opened any presentations recently. Pick a place to browse for a presentation,

Recover Unsaved Presentations

Step 3. Click on Browse button.
Step 4. Click on This PC option.
Step 5. Select the presentation.

Step 6. Click on Open button.

Fact W& Know

Prevenlatund - Sowert wgnin B o
Sy Preventations  Folders
Wi P T OEAR Bty PIEIETIRDOPR ASCETTy. Puck & DUCH 10 Mrowde Ror & pvg [T ®
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& Lecal Disk T
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Racons e Frassetszom

Fuecoer Urnaved Presentaton
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~ Local Knowledge

We can press the Ctrl + 0 keys together to open an existing presentation in PowerPoint 2019.
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RUNNING A PRESENTATION
After creating slides, we can run our presentation. PowerPoint gives us the
option of presenting a series of slides called slide show. In a slide show, all the
slides in our presentation are displayed one by one. A slide show can be
started in one of the following ways :
©  Click on the Slide Show button on the Quick
Access Toolbar.
©  Click the Slide Show button present at the Status bar of PowerPoint
window to begin a slide show from the current slide.
= Notes W comments = = T — B + 88% (A

© Click the Slide Show tab. Click the From Beginning button in the Start
Slide Show group.

H 043 - - Presentation5 - PowerPoint Eal
File Home Insert Draw  Design  Transitions  Animations ESIGESUGIYEN Record  Review  View  Help Q Tell me S Share
=) L’.j ;J:r l—:_"_ P A | .| o] Play Narrations =¢ Monitor: |Aut0mat|c "
F__ F-_ C i lid S Ui Hide R h._ Record bl Use Timings -
fon? rom_ ustom Slide : et Up i e g e_arse ecor = ) /] Use Presenter View
Beginning Current Slide Show ~ Slide Show Slide  Timings ~ [~/ Show Media Controls
Start Slide Show Set Up Monitars ~
~—

Fact KhOW _ Local Knowledge

We can also press the F5 key to start a slide show.

(ocollict the

©  MS PowerPoint is a software used to create presentations. A presentation includes text, pictures, charts,
audio, video and some animated effects.

© A presentation is a collection of slides arranged in systematic order which display the information on a
particular topic.

©  Jlides are the individual pages of a presentation which display one by one on a screen.
©  We can view the slides using the Normal, Slide Sorter, Reading View or Slide Show buttons.
© Toinsert atextin a placeholder, click inside it and start typing.

@0/%/9{45@? MANNER @B

Always share your computer with your friend, brother or sister. Never fight near the computer.
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Tick (V) the correct answer :

1. A slide is displayed in the at the centre of the PowerPoint
window.
(a) Placeholder (b) Slide Navigation Pane
(c) Slide Pane (d) Notes Pane

2.  To change the layout of a selected slide, click on the option.
(a) New Slide (b) Reset (c) Layout (d) Theme

3.  Which of the following view buttons displays miniature form of all the slides in
a presentation?

(a) Normal (b) Slide Sorter (c) Reading View [ (d) Slide Show
4.  Which key is pressed for a slide show?
(a) F2 (b) F3 (c) F4 (d) F5
5. tab has the options to apply themes to a blank presentation.
(a) File (b) Insert (c) Design (d) Themes

Write ‘T’ for true and ‘F’ for false in the given circles :
1 Reading View hides all the editing tools to make your slides easier to review.
2 Once we select a slide layout, we cannot change it.
3.  We cannot edit a slide in the slide pane.
4 The Layout button is present in the Slides group on the Home tab.
) Whenever we start a new presentation, it will contain one slide with Title Slide
layout by default.
Fill in the blanks :
is the default view.
In a , all the slides in our presentation are displayed one by one.
view hides all the editing tools to make our slides easier to Review.
Notes Pane is also known as :
Is a dotted rectangular box on a slide that holds text, images, etc.

o W=

Answer the following questions :

1. What are slides?

2.  What do you mean by presentation?

3.  What is the use of Slide Navigation pane?
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4. Explain the different view buttons available on the status bar.
5. Write the steps to start PowerPoint 2019.

‘(rea'!'.iVﬂ:U Ski "5 Dﬂj Art Integr&ﬁ

4 )

Draw and colour the logo of PowerPoint 2019 in the space
given alongside :

Prepare a presentation of 6-7 slides on the topic ‘Computer Software’.

Experience-based Questions Higher Order Thinking Skills

1. Swati has created a blank presentation, but later she decided to apply a theme to
the presentation. Can you suggest her how she can add a theme to the selected
slides and to all the slides of the presentation?

2. Nitin has made a presentation on the topic ‘Health is Wealth’, and saved the
presentation by the name ‘Health’. Next day, he has made the changes and saved
the presentation again.

(@) What will he do to save the changes in the same file ‘Health’?
(b)  What will he do to save the changes by another file name ‘Health is wealth’?

*—

Think & Answer Life Skills & Values

Your teacher teaches you a new application but you are unable to understand, then what
will you do? You will pretend that you understand, or ask with your friend or teacher to
understand it. Justify your answer.

_Discussion Communication \

Discuss the different components of PowerPoint 2019 in class in detail.

Teacher's Help
©  Explain how PowerPoint is beneficial in the present scenario to the students?
©  Give the tips to students on how to present the slide in an impressive way in front of a large audience.
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In this chapter, you will learn about :

O  PRINT Command ©  FONTSIZE Command
0 (GO Command o  ASK Command
©  MESSAGE Command ©  Maths in KTurtle

More on KTurtle

Ot ]

We have learnt about KTurtle commands in previous chapter. Now, we will
learn about the commands used to write on the canvas. We will also learn how
to perform simple mathematical calculations in KTurtle.

PRINT COMMAND

The print command is used to write the text or numbers on the canvas by the turtle.

The steps for using the print command are as follows :

Step 1. Type the print.
Step 2. Press the Spacebar key.
Step 3. Do the following :

(a) To display any number, type the number.
(b) To display text, enter the text using double quotes (“").

! KTurtle
File Edit Camves Run Tools Seftings Help

©rew L open Hfave WA swens | (Drin v (rsse () ot o
-

[Editor

It will display the number
2018 as shown. 1. Type the

commands
as shown.

2. Click on the

Run button.

.

L

English [Built in] ~ Line: 2 Column: 1 [INS

@ x
vorsbies | rie V|

s

ntitled
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FONTSIZE COMMAND

The fontsize command is used to set the size of the font that is used by the
turtle. It takes one input which should be number.

The steps for using the fontsize command are as follows :

Step 1. Type the print.
Step 2. Press the Spacebar key.
Step 3. Type the number of units for

fontsize.

i“l‘hnh
Ete Eft Coves Bun Took Semings Help

[t resex

PRLD OF KTURTLE

L] 2

g b Lo 4 Cotrnn 1905w

Let us type the text vertically.

It will display the text vertically.
GO COMMAND

The go command is used to move the

turtle to a certain place on the canvas
without drawing a line. The position

of the upper left corner of the canvas i

is given by O, O.

\\
® @ o

B Tt
Eile & Qaovws Bun Jook Settings Help

Dren flooen | e b seens  @mn = (0 Camole: | =] [ e
B 8% r— %
n zeens el L L

b froe Tt

|
2018
)

Englah [buit in] | Line: 3 Column: 1 (15 untitled

It will display the number 2018 bigger
as shown.

Now, let us type the text on canvas.

I ppaci @ x|
. oviables. | "\rJ’
a®
<
(=]
g
=
ol Ly |
tngheh il Une § Coume 1 15 it
.
s 5 oo
1ranecme ax
s | my [0
o Toi
FLHawe a nice day
L |
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The number of steps the turtle will move is calculated from that position. For
example, go 60, 100 moves the turtle 60 steps to the right (counted from the
upper left corner of the canvas) and 100 steps down on the canvas.

The go command moves the turtle from upper left corner, 20 steps to the right
and 100 steps down on the canvas. Then it writes the text at the position of the
turtle horizontally. Now, it moves the turtle from upper left corner, 10 steps to the
right and 180 steps down on the canvas. Then, draw the border around the text.

ASK COMMAND

The ask command is used to enter a number or text, so that we can give
answer to the question. This command starts with $n followed by an equals to
(=) sign. On the right side of the equals to (=) sign, type ask followed by some
text enclosed in double quotes (“").

Syntax : 5 Input - KTurtle ? >
$n= ask “Type the text here” i
|Iamﬁne| <
For example : i |
¥ 0K | Cancel
$n= ask “How are you?”

It will display a question asking us to enter the answer as shown in figure given
alongside. Enter the answer and click on the OK button to answer the question.

MESSAGE COMMAND

. . . . # Message- ... ? =
The message command is used to give some information
by showing the text typed by us. €Y rormnsneriscomest
For example : 5
message “Your answer is correct.”
T T ! = =SS 2. Click on the S UES B
i & Run button. ]
|
ﬁNew ||=“10pen HSave MSave As @Run G @Pause O Abort |Console: | J »,
\Editor g X Inspector g x|
' e 3. Enter your Vari HF_JL
2 %n = ask "Enter you name here. . |

i 3 message Sn+ “is very & Input - KTurtle 4. Click on OK |

Enter you name button.
[Mahi

1. Type the
commands
as shown.

English [built in] | Line: 2 Column: 3 | INS 15.turtIeF
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&

) Mew L. Open L—j Save M Save As @ Run v @ Pause 0 Abort |Console: ] _J >
|Editor g X Inspector = 4
1 reset | Variables ] Fur * | ¥
2 $n = ask "Enter you ﬁ Mezzage - KT... ? >
namne " name typ
||3 mESsage $n+ "is very = - g :
v ol 0 Mahiis very hard working, &n Mahi  strit
| @ OK
I
| | | =

English [built in] | Line: 2 Column: 3 | INS | 15.turtle

It will display the message box as shown.

MATHS IN KTURTLE

We can perform addition, subtraction, multiplication and division using the
symbols +, —, * and / respectively. These symbols are also known as arithmetic
operators. These symbols are used with the print, forward, backward, turnright,
turnleft, direction and go commands and usually take two inputs.

Using Print Command

Let us understand the use of arithmetic operators using the print command
with the help of some examples.

reset reset reset reset

go 50,100 go 50,100 go 50,100 go 50,100
fontsize 80 fontsize 80 fontsize 80 fontsize 80
print 49 + 100 print 100 — 77 print 50 * 40 print 345 /5

&

2000 69

» »

149 23

Using Other Commands

Let us understand the use of arithmetic operators using other commands with
the help of some examples.
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fw 100+70 bw 20 * 5 tr 45 * 3

It moves the turtle It moves the turtle It turns the turtle
by 170 steps in by 100 steps in right by 135
forward direction. backward direction. degrees.
¥ 3
go 100 + 40, 50 + 50
tl 240 / 2 Dir10 * 3 * 5 It moves the turtle
It turns the turtle It turns the turtle :;?:erthf 4lé)p§tirpiei
left by 120 degrees. right by 150 degrees. the right and 100
steps down on the
# & canvas.

*

@coe&ct the (S

The print command is used to write the text or numbers on the canvas by the turtle.

©  The fontsize command is used to set the size of the font that is used by the turtle. It takes one input which

should be number.

© The go command is used to move the turtle to a certain place on the canvas without drawing a line. The

position of the upper left corner of the canvas is given by 0, 0.

© The ask command is used to enter a number or text, so that we can give answer to the question. This
command starts with $n followed by an equals to (=) sign. On the right side of the equals to (=) sign, type

“un

ask followed by some text enclosed in double quotes (“”).
©  The message command is used to give some information by showing the text typed by you.

Always keep your fingers, pens and pencils away from the computer screen.
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Tick (v) the correct answer :
1. Which of the following operators is used for addition?

(a) * (b) - (c) + (d) All of these
2. Which of the following commands turns the turtle right by 180 degrees?

(a) t1 90 + 90 (b) tr 180 -90<( ) (c)dir90 * 2 (d) None of these

3. Which of the following commands moves the turtle 30 steps to the right and
40 steps down on the canvas from the upper left corner?

(a) go 20 + 10,20 * 2 (b) go 40, 30
(c) fw 30 + 40 (d) None of these
4.  The ask command starts with followed by an equals to (=) sign.
(a) &n (b) $n (c) =n (d) All of these
5. Which of the following operators is used for multiplication?
(@) / (b) * (c) - (d) Both (a) & (b)

Write ‘T’ for true and ‘F’ for false in the given circles :

1 We cannot change the size of the font used in print command.

2 The fontsize command takes one input which should be number.

3.  The ask command starts with $n followed by an equals to (=) sign.
4 The output of the command print 60 + 60 is 180.

5 The arithmetic operators can also be used with go command.

Fill in the blanks :

1. The command is used to move the turtle to a certain place on
the canvas without drawing a line.

2. The +, —, * and / symbols are called operators.

3. The command is used to set the size of the font that is used
by the turtle.

4, The command is used to write the text or numbers on the
canvas by the turtle.

5. The command is used to give some information by showing

the text typed by us.

Answer the following questions :

1. What is the use of fontsize command?

2.  What is the use of go command? Write the command to move the turtle 100
steps to the right and 150 steps down on the canvas.

2.
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3.  What is the use of print command?
4.  What is the use of message command?
5. What is the use of ask command?

‘(rea'!:iVﬂ:H Skills ] Dﬂj Art Integration |

2

Draw and colour the picture of KTurtle in your notebook.

Write the commands for the following in KTurtle :
1.  Add 100, 200 and 300. 2. Divide 450 by 5.
Multiply 245 by 7. 4. Subtract 1987 from 3456.
Type your name vertically with font size 70.
Type the name of your friend horizontally with font size 50.
Ask a question using ask command.
Display a message using message command.

N oW

Experience-Based Questions Higher Order Thinking Skills

1. Atul wants to change the size of the text while using the print command. Can you
help him in completing the task?

2. Rachit wants to type his father's name vertically from 100 steps right and 200
steps down from the upper left corner on the canvas. Suggest him appropriate
commands to complete the task.

Think & Answer Life Skills & Values |

What do you prefer— solve the mathematical calculations in a notebook or in KTurtle? How
will the option that you choose saves your time?

Activity Work Cutting & Making Skills |
Prepare a chart on ‘Mathematical Calculations in KTurtle’.
‘DiSCUSSiOI"\ Communication

How can you write text in KTurtle? Discuss the different commands in class.

Teacher's Help

© Demonstrate how the arithmetic operations used with print command and other commands to perform
mathematical calculations in KTurtle to the students in detail.
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In this chapter, you will learn about :

O Internet O Uses of the Internet
©  History of the Internet © Internet Terms

©  Accessing a Webpage using a Browser O  Search Engines
INTERNET

Internet, popularly known as the net, is
one of the greatest scientific achievements
of the modern man. It has brought the
entire world at our fingertips. The Internet
stands for International Network. When
millions of networks are interconnected

the Internet.

USES OF THE INTERNET
Some of the uses of the Internet are :

1.  We can buy and sell products on the
Internet.

2. We can book airline/railway/movie
tickets.

3. We can get a lot of information on any
topic on the Internet.

4. We can chat with people on the
Internet. e

5.  We can pay bills through the Internet.
6. We can send messages, known as e-mails to any part of the world.
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HISTORY OF THE INTERNET

The Internet was initially known as ARPANET (Advanced Research Projects
Agency Network). It was implemented by the DOD (Department of Defence) of
the USA. Later on, it connected different universities and defence organisations
to share information on research and development in scientific and military
fields. It was a big success. Subsequently, it was made available commercially
to the people and has taken the shape of the present-day INTERNET.

INTERNET TERMS
Let us learn about some important terms related to the Internet.

Webpage

The pages which collectively form the World Wide Web are known as
webpages. A webpage is created using a language called HTML (Hypertext
Markup Language). These pages may contain text, images, videos, audios and
links to other pages.

ISP

ISP stands for Internet Service Provider. An ISP is a company that provides
Internet access to the users. Some of the popular ISPs are Jio, Airtel, Idea,
Vodaphone, Tata Docomo, and BSNL (Bharat Sanchar Nigam Limited).

4
@ . l 'dea) BSNL
outel vodafone Rositing e

Hyperlinks

The link that connects one page to another is known as a hyperlink. Thus, a
hyperlink allows you to move to some other webpage with related information.
When the mouse pointer is moved over a hyperlinked image or text, the pointer
changes to a hand symbol. Clicking on the hyperlink takes you to a different

page.
WWwW

WWW stands for World Wide Web. It is a collection of interconnected pages
that contain text, pictures, audios and videos. The various pages are connected
using links and can be accessed through the Internet by the people all over the
world. Shareable information on the Internet is called the World Wide Web.
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Fact KDOW . Local Knowledge

World Wide Web is popularly known as the Web or W3.

Web Browser

Information on a website is accessed by using the Internet application called
the browser. A web browser is a software that lets you access the pages on the
World Wide Web. Some popular browsers are Microsoft Edge, Internet Explorer,
Google Chrome, Mozilla Firefox, Opera, Apple Safari and UC Browser.

Website

The location where the information is available on the web is called a website.
It is a collection of one or more related webpages linked together.

RCE

Home Page

Each website has a main page which contains links to other pages. When you
visit any site, the first page that opens is called the home page.

o—

Fa CtKnOW . Local Knowledge

The home page of a website can be changed or updated by the owner of the website.

URL

URL stands for Uniform Resource Locator. Every website or webpage has a
unique address. The address of a website or a webpage is known as the URL.
All the addresses start with either http: or https: (where ‘s’ stands for secures).
You would find such an address on bank websites in which money is involved.

Some of the URLs are :

©  http://www.discovery.com

© http://www.indianrail.gov.in

® http://www.nationalgeographic.com

© http://www.history.com

Never leave a space in between the words/letters while typing the URL of a

website.
, 2.
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Internet is a very useful tool. However, at times, it can also be dangerous and
harmful. Some of the important safety tips are as follows :

If you join a
chat group with your
parent's permission, you
should never give out your

assword to anyone
Do not send P y

in that group. g
your picture on the group Be polite and
Internet without asking respectfull_ of others
online.

your parents.

Do not give

your personal
information like your address,
your parents’ contact number,
name, location of your school,

etc. without your parents’
permission on
the Internet.

When you come
across information that
you do not like or is
upsetting you, inform and
discuss with your parents
about the same.

ACCESSING A WEBPAGE USING A BROWSER

As a web browser is required to access a webpage, we are taking up an
example of Internet Explorer here. Let us look at its general features.

Starting Internet Explorer
To start Internet Explorer, follow these steps :

Click on the Start
button.

Click on the All apps.

Click on the Windows
Accessories.

Select Internet Explorer.

EEnEEE s =

The Internet Explorer window opens.

Parts of the Internet Explorer
The various parts of Internet Explorer are as follows :
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Back button  Address bar __, Refresh button

Favourites button
[ Home bUHOTh T — > Tools
~ 1 d [x button
Ei vite msn.comen-init © = & || [ MSN India | Hotmail, Outlo... T
*m n b ping  web search Sign in # o
Forward(— IPL 2007 MEERUT J 39°C 4 NEWS ENTERTAINMENT SPORTS MONEY LIFESTYLE HEALTH FOOD TRAVEL Al
button

Kerala law student chops off
genitals of 'rapist’ godman

Work anywhere; anytime, on any device with
Ofﬁce 365 Shop NOW i b .l proposes to Dipika Kaldar

Shoaib Ibrahim finally

< >
#]100% ~

v

Inspector pane

Address Bar

The URL of the website is entered in the address bar. After entering the URL,
press the Enter key.

Back Button

The Back button takes us to the web page which we were viewing, before
coming to the present page.

Forward Button

The Forward button has the opposite function of the Back button. It takes us
forward to the next web page, within a sequence of pages that we have already
accessed.

Refresh Button

The Refresh button is used to reload a webpage. It can be used when the page
has not displayed properly or to check and see if any changes have been made

to a page since the last visit.
\ 13,
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Favorites Button

The Favorites button is used to save the URL that we like and may want to visit
later. If we want to make any URL favorite, follow these steps :

. 1. Click on
o [] 9 P~ [] MEM India | Hotmail, Outlo.. the Favorite
button.
Add o favorites | ¥
’j msn b Bing | webse: :

Favorites Feeds

Add to favor

Faverites Bar
IPL 2017 . MEERUT /39°C # NMEWS  ENTERTAINMENT SPORTS MONEY  LIFESTYLE HEA h Bing

e
Add a Favorite x

2. Click on the
Add to favorites
button.

NOT TO BE MISSED -

Add a Favorite
Add this webpage as afavorte. To access yourfavortes, visit the
Favorites Center.

ey
e |

MName: MSHN India Hotmail, Outlook:, Skype. news. p

Createin: 5.7 Favortes w MNew folder

3. The Add a Favorite
_ dialog box appears. Click
on the Add button.

Kate's concern about Pippa‘s . Turn on Suggested Sites..
day Weird sunglasses of celebs I ) .
| q | T
) ' ; proposes to Dipika Kakar
B MNowTolove = India Today "
. W

[T
>
£100% -

*—

Fact KI'IOW . Local Knowledge

Sir Tim Berners-Lee is the founder of the World Wide Web.

The URL gets added to the list of favorites. You can click on it to access the
website.

Tools Button

It allows the user to use features like Print, History, etc.

Home Button

It is used to display the home page of the browser that opens on its own when

you open a browser. ——
Local

SEARCH ENGINES FactS I KGhow Knowledge

A web search engine is a website that Larry Page and Sergey Brin are
helps us search for information on the the founders of Google.
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World Wide Web. Search engines allow the user to enter a keyword related to
the information we require and search the websites containing a particular
information. These websites are popularly known as search engines. The
search results are usually presented as a list of links. The links may point to
text, images, audio or video files.

Examples of search engines are :

Google : http://www.google.com

Alta Vista : http://www.altavista.com

Bing : http://www.bing.com

To search any information on the net, follow these steps :

Open the Browser .
and go to the e~ ~a—
search engine
website.

Enter the word,
phrase or sentence
related to the
information that you
want to search for.

Click on the hyperlinks that the search engine shows as results.

@@co@@act the G

The term Internet stands for International Network. It is a huge network of computers around the world.
ISP stands for Internet Service Provider. An ISP is a company that provides Internet access to the users.

©  WWW stands for World Wide Web. It is a collection of interconnected pages that contain text, pictures,
audios and videos.

©  The link that connects one page to another is known as a hyperlink. Clicking on the hyperlink takes you to a
different page.

© The location where the information is available on the web is called a website. It is a collection of one or
more related webpages linked together.

©  URL stands for Uniform Resource Locator. The address of a website or a webpage is known as the URL.

o

Do not attempt to repair, open, temper or interfere with any of the computer, printing, cabling, air conditioning or
other equipment in the computer lab.
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X Fxercice

Tick (V) the correct answer :
1. Which of the following is not an ISP?

(a) Jio (b) BSNL (c) Airtel (d) Google Chrome
2.  We can use Internet to :
(a) buy products (b) pay bills
(c) chat with people (d) all of these
3. Which of these is used to reload a webpage?
(a) Forward button (b) Refresh button
(c) Stop button (d) Back button
4.  Which of the following is an example of a web browser?
(a) Search Engine (b) ISP
(c) WWW (d) Internet Explorer
5. What is a collection of related webpages linked together called?
(a) Web Browser (b) Hyperlink (c) URL (d) Website

Write ‘T’ for true and ‘F’ for false in the given circles :
1. We can get a lot of information on any topic on the Internet.
2. A webpage is created using a language called HTML.

3. The Forward button takes us to the web page which we were viewing,
before coming to the present page.

4.  The pages which collectively form the World Wide Web are known as
hyperlinks.

5. Home button is used to display the home page.

Fill in the blanks :
1. When we visit any site, the first page that opens is called the
2.  The Internet was initially known as

3. The button is used to save the URL that we like and may want
to visit later.

4, is a collection of interconnected pages that contain text,
pictures, audios and videos.

h. The URL of the website is entered in the

Answer the following questions :
1. Define ISP and WWW.
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2. What is the difference between webpage and website?
3. What is the Internet? Give any two uses of the Internet.
4.  What do you mean by search engines? Name any two search engines.
5. What is the role of web browsers?
‘(rea'l:iVﬂ:H Ski "S ] Dﬂj ) Art Integration

Draw and colour the picture of any two web browsers in your notebook.

Open the Internet Explorer and type the URL of Google search engine and search
information on ‘History of Internet’.

Experience-Based Questions Higher Order Thinking Skills

1. You want to buy some books through the Internet but you don’t know which
websites you should visit for that purpose.

(a) What should you do to get the websites addresses?
(b)  What is the term used for moving from one webpage to another?
2.  Your father wants to pay electricity bill through the Internet but he does not know

which website he should visit for that purpose. Suggest him the method to get the
website addresses.

Think & Answer Life Skills & Values |

Is it right to spend most of the time on the internet and using it every time you do your
homework? Justify your answer.

_HCHVI.IZH Work Cutting & Making Skills
Prepare a project file on ‘Internet’.
_DiSCUSSiOh Communication

Divide the class into groups of five each. Discuss the different uses of Internet in detail.

Teacher's Help
©  Summarize the lesson and allow the students to do Internet based activities on the computer.
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More About Scrutcil

LEARNING [0]8)e{e] !X

In this chapter, you will learn about :

©  Components of Scratch ©  Working with Two Sprites
O  Setting the Rotation Style ©  (Changing the Pen Shade
©  (Changing the Stage Backdrop

A programming language has a set of instructions called program, for
instructing a computer to perform specific tasks.

Scratch is a simple programming language that lets us create our own
interactive stories, animations, games, music, and art.

Playing video games is fun, but programming in own video games is a creative,
challenging skill that lets us make our own fun. The free Scratch programming
environment gives everyone an easy way to learn programming skills.

Scratch was designed by the MIT (Massachusetts Institute of Technology)
Media Lab’s Lifelong Kindergarten Group, led by Mitch Resnick in 2003.

COMPONENTS OF SCRATCH Sprite Toolbar

Title Bar  Mehu Bar

. or Cursor Tools
The various parts of the T I
Scratch window are e o
. . . View Full — = . » Tabs

shown in figure given  screen = ° T
ahead. In the previous "< 1
Stop Button «
class, we came to know L8
——  Script
about some of these  stage «— '====', A
parts. Let us learn about Sprite «

more of them. Stege <! Tm
Icon » Blocks
T — Palette

pr|+e List New Sprite
Buttons

» Block Mehu

=]

Backdrop Icohs
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Stage

|t is the main working area where all of the action takes place by the Sprite as per
the given instructions. It displays our creation. We can see our stories, games,
and animations created by us. It is divided into (x, y) co-ordinates ==+=1present
at the bottom-right corner of the stage, which shows the position of the mouse.

Sprite

Scratch projects are made up of objects. The most basic object in Scratch is
the Sprite. It is a small graphic character that performs actions in Scratch
projects. There are many in-built Sprites in Scratch. Cat is the default Sprite in
Scratch.

New Sprite Buttons |newspie & / &t |
There are four new sprite buttons to add a sprite.

) Choose sprite from library : Using this option, we can pick one from
Scratch’s built-in library.

© Paint new sprite : Using this option, we can draw a new one.

) Upload sprite from file : Using this option, we can upload an image you
already have.

© New sprite from camera : Using this option, we can take a photo with our
computer’s webcam and use it as a sprite.

View Full Screen

The View Full Screen button or presentation button is used to play our project
in full screen mode.

Sprite Toolbar or Cursor Tools

Once we have created the Sprite, we can make duplicate of it, increase or
decrease its size or delete it by using the Sprite toolbar or Cursor tools.

® Duplicate [7] : It creates another copy of the Sprite.
Delete []: It deletes the Sprite.

Grow[]: It increases the size of the Sprite.
Shrink [Z] : It decreases the size of the Sprite.

Block help . On selecting this button, the mouse pointer will change
into a question mark. If we click on any block in the block palette with
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Tabs

the question mark, a pop-up window appears which shows the quick tips
for that specific block. We can also open the tips window by clicking on
the Tips option present on the menu bar.

Scratch provides three different tabs- Scripts, Costumes and Sounds.

(O]

Scripts tab : Script is a set of stepwise instructions given to the Sprite to
do a specific task. Script is also called a program. Each instruction is also
called a command. It consists of the block menu and allows you to write
a script.

Costumes tab : It allows us to draw, import or edit images for a Sprite.

Sounds tab : It allows us to record or import sound files for a Sprite to
use.

In addition of these tabs, the Backdrops appear in place of the Costumes tab
when we select the Stage icon.

Backdrop Icons

The backdrop icons are used to change the stage background. Scratch itk
provides four different options to change the backdrop of the stage. /-

1.

Choose backdrop from library : Using this option, we can choose the
backdrop from the Scratch library.

2. Paint new backdrop : Using this option, we can create a new backdrop
window according to our requirements. It opens the ‘Backdrops Window
Editor’.

3. Upload backdrop from file : Using this option, we can upload the required
file for backdrop.

4. New backdrop from camera : Using this option, we can take a photo with
our computer’s webcam and use it as a backdrop.

Stage Icon

On clicking this icon, the Backdrops tab appears in place of the Costumes tab.
We can import any background on the stage using this tab.
Sprite List

Here are the characters and objects we’ve created, including the stage itself.
Click the icons to edit each sprite individually.
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Sprite Info Pane

We might have noticed a little blue icon g
in the left corner of the sprite thumbnail in
the Sprite List. It displays the Sprite Info
Pane when we click on this icon. It
includes the information about the selected sprite as well as a few tools for
manipulating the Sprite. The tools include :

Sprite’s Name : This is how we can rename the sprite.

x: and y: co-ordinates : The position of the sprite is indicated by these
coordinates on the stage. The horizontal line is labelled as x-axis and the
vertical line is labelled as y-axis.

Direction : It includes how the sprite will turn when it executes a move instruction.
Rotation style : We can control how a sprite rotates in three ways:

o  Can rotate freely

© Can face only left or right [~
© No rotation allow [ ¢]

WORKING WITH TWO SPRITES

To create a project with two sprites, follow these steps :

Step 1. Click on the Choose sprite from library option. The Sprite library
dialog box appears.

Step 2. Select the People from the Category section and select Kai. Then,
click on the OK button.

Step 3. Again click on the Choose sprite from library option and add Maya
Sprite from the People category of the Sprite library dialog box.

Step 4. Select the sprites one-by-one and start creating the block stack step-
by-step as shown in figure.

Step 5. Click on the green flag button and observe the two sprites talking to
each other.

~e
&

Why are you so
. upset?
when dicked I have got less
= e marks in Maths.
1

ERITE Hello Kal! }
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Changing the Sprite Position

{%:0,¥:0) (%:240,¥:0)
+ 4

1 C0,¥:-180)

The Scratch is 480 pixels wide and 360 pixels high. Everything is on a grid
with two axes— x-axis and y-axis.

x-axis : A horizontal line that marks left and right positions; ranges from —240
(farthest left) to +240 (farthest right).

y-axis : A vertical line that marks up and down positions; ranges from —180

(lowest) to +180 (highest).

The default position of sprite is at the point where the x-axis and y-axis meet

called origin (X: O, Y: 0).

As we move to the right [«

from the origin, the x-
value increases from O to
240. As we move left
from the origin, the x-
value changes from O to
—240. Similarly, as we
move up from the origin,
the y-value increases from
O to 180. As we move
down from the origin, the
y-value changes from O to
—180.

/e

h 2 Offine Editor = o X

Let us create a project to change the sprite’s position.
Drag the following commands and observe the result.
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Blocks Used in the Project
This block is used to set the x position of the sprite.

set y to @D This block is used to set the y position of the sprite.
o0 to x: @D v: @ This block is used to go to the specified position on the
stage.
Fact KnO'W' ~ Local Knowledge

We can use the block EZX B L) to move a sprite smoothly to an xy position on the stage.

SETTING THE ROTATION STYLE

We can set the rotation style of the sprite by using the Rotation Style button
present in the Sprite Info Pane.

Let us create a project.

Click on the Choose sprite from library option. The Sprite library
dialog box appears.

Select the People from the ===
Category section and select Zara. * e -
Then, click on the OK button.

Now, click on the @ icon present &
on the left corner of the sprite to
open the Sprite Info Pane. —, —

Set the rotation style to Linear % - =
Arrow [=]. - _—
Drag the following commands and

observe the result.

CHANGING THE PEN SHADE =

T ‘

'

As the Sprite moves on the stage, Pen block is Qf‘ '._
used to draw a trail. Each pen colour has P = E
different shades that vary from O to 100 i_

(lightest to the darkest) i.e. O is the lightest and
1 is the darkest shade. (&)

Let us create a project. E
\ 13,
) Computer-4 o
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Drag the following commands and observe the result.

CHANGING THE STAGE BACKDROP “"“'" = EEED -
We can change the backdrop, ie. - rﬂ-;
background of the stage. To change the S e
backdrop, follow these steps : S
. [ —n® ]
Step 1. Click on the Choose backdrop o
fro;n library option available & m——
under New backdrop section. . o
@ ...... _
[—--0]
o [ eree < 1 €D
Sres ] e

Step 2. Select the desired backdrop. mm “ - E

.....

Bench wn new

Step 3. Click on the OK button.
Step 4. Drag the following blocks and . }&
observe the result. |

ﬂ—_u
) §
Al

Let us Create a Dancing Sprite project.

Step 1. Click on the Choose sprite from =
library option. The Sprite library E
dialog box appears.

Step 2. Select the People from the @&
Category section and select _—
Ballerina. Then, click on the OK T
button. E—

Step 3. Click on the Choose backdrop
from library option available
under New backdrop section.

o]
) Computer-4 &
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Step 4. Select the spotlight-stage backdrop.
Step 5. Click on the OK button.
Step 6. Now, drag the following commands and observe the result.

Blocks Used in the Project

This block sets the type of instrument that the
sprite uses for play note blocks.

This block plays a musical note for specified
number of beats.

Paint New Stage Backdrop
To paint and create a backdrop of the stage, fum
follow these steps :

Step 1. Click on the Paint View backdrop
option  available under New
backdrop section.

Step 2. Use the available tools to design a Hg

Fee=-00-/0

| R Sam=a
— _BnpisE.
ML .

backdrop.
Fa CtKnOW ~ Local Knowledge
To delete the backdrop, right-click on the backdrop in the backdrops list under the :”m":‘ z
Backdrops tab and select the Delete option. D l

@acog&ct the (G

A Scratch is a simple programming language that lets you create your own interactive stories, animations,
games, music and art.

©  The Scratch is 480 pixels wide and 360 pixels high. Everything is on a grid with two axes— x-axis and y-axis.

©  The x-axis is a horizontal line that marks left and right positions; ranges from —240 (farthest left) to +240
(farthest right).

© The y-axis is a vertical line that marks up and down positions; ranges from —180 (lowest) to +180
(highest).

©  The default position of sprite is at the point where the x-axis and y-axis meet called origin (X: 0, Y: 0).
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Tick (V) the correct answer :
1.

When we click on @ icon in the left corner of the sprite thumbnail, it displays
the

(a) Sprite list (b) Block help

(c) Backdrops tab (d) Sprite info pane

It creates another copy of the sprite.

(a) Delete (b) Duplicate (c) Grow (d) Shrink
There are new sprites buttons to add a sprite.

(a) two (b) three (c) four (d) five
We can change the backdrop of the stage using option.
(a) Choose backdrop from library (b) Paint new backdrop

(c) Upload backdrop from file (d) All of these

The x-axis ranges from—

(a) -180 to 180 (b) =240 to 240

(c) =480 to 480 (d) none of these

Write ‘T’ for true and ‘F’ for false in the given circles :
1.

On clicking the Stage icon, the Backdrops tab appears in place of the
Costumes tab.

We cannot delete the backdrop.

A programming language has a set of instructions called program.

The block plays a musical note for specified number of beats.
As the Sprite moves on the stage, Pen block is used to draw a trail.

Fill in the blanks :
1.
2.

The tab allows us to record or import sound files for a sprite.

The default position of sprite is at the point where the x-axis and y-axis meet
called

A is a small graphic character that performs actions in Scratch projects.

The Scratch is pixels wide and pixels high.
The tab allows us to draw, import or edit images for a sprite.
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D. Answer the following questions :

What is Scratch?

What is the role of Sprite Info Pane?

How can you set the rotation style of the Sprite?
What is Sprite?

Explain new sprite buttons.

o s W=

=(r ea'lfiVﬂ:H Ski"S i DHA Art Integrm

2

Draw and colour any one Sprite in your notebook.
_h’ OjEC‘!: TiMC Practical Skills
"Q '

*-—

Experience-Based Questions Higher Order Thinking Skills

Create a dancing sprite project in Scratch with the following
Sprite and backdrop as shown alongside :

Sprite- Cassy Dance (Dance Theme)
Backdrop- spotlight-stage?

1. Jatin wants to play a sound of Flute in his Scratch project. Suggest him the
appropriate block to complete the task.

2. Nidhi is creating a project in Scratch. She wants to set the rotation style of the
Sprite. Can you help her in completing the task?

*—

Think & Answer Life Skills & Values

If your teacher tells you to improve your project then what will you do— ighore what he/she
says, copy from your friend and show to your teacher or listen to your teacher and improve
your project?

[

‘DiSCUSSiOI"\ Communication

Discuss the uses of various components of Scratch window in class.

Teacher's Help
©  Summarise the lesson and give the students enough activities for practice.
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Artificial
Intelligence

Robots

Robots can be defined as machines that have human-like tendencies and capabilities. They
can perform tasks according to their programming. For the past decade or so, robots have
demonstrated immense significance by decreasing the workload of humans, especially in the
industry sector.

Typically, robots are put into use in the manufacturing F
industry. Laborers usually find these jobs monotonous :
and repetitive. When people perform a specific role for
a long time, it is natural for them to get bored of what
they have been doing and want an out or complete the
task unwillingly.

This will also reduce the effectiveness of such people ,,_i»— -

as compared to when they began working. As a result,
they end up feeling burned out without any eagerness
or enthusiasm to continue the work. That is precisely
where robots come in the picture to make the lives of humans easier than ever.

—

Even though in popular fiction a robot resembles a humanoid, in reality, they may have
different shapes depending on their function and utility. They can undertake many types of
tasks, from cooking and cleaning to heavier ones like assembling large machinery. The
development of modern industrialization is dependent on the development of robotics.

In the modern world, one can find robots anywhere, even in daily life.

° Robot vacuum cleaner : With a few instructions, the vacuum cleaner can clean the
entire floor surface with no human intervention.

° Robot lawn mower : Again the owner can set a few instructions, and the entire lawn
will be mowed while the owner can tend to other tasks.

° Drones : They are being developed as a surveillance device or for delivery of small
items such as pizzas, etc.

° In factories, robots are used to set up assembly lines to minimize human labour.

° A lot of computer programs use robots to hack into other peoples’ computers or
software.

Using robots cuts down on a lot of human effort, yet its scope is limited and needs some
supervision by human intelligence. Industries have reaped a lot of benefits from the
applications of robots in the past few decades. Their utilization has also led to a massive
increase in the company’s productivity and profits. Robotics mixed with artificial intelligence
has made it easy for humans to perform complicated or tedious tasks and this technology is
only expected to grow in the future.
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Model Test Paper-

A. Tick (v) the correct answer :
1. Which of the following is not a secondary storage device?

(a) Hard disk (b) RAM (c) CD (d) Blu-ray disc
2.  The picture appears as a background on the desktop is called

(a) Desktop (b) Picture (c) Wallpaper (d) Theme
3.  The Spelling & Grammar tool is present on the tab.

(a) File (b) Home (c) Review (d) Insert
4. Which of the following options is not available on the Home tab?

(a) Bold (b) Italic (c) Thesaurus (d) Underline

B. Write ‘T’ for true and ‘F’ for false in the given circles :
1. Secondary memory is also known as external memory.
2. We cannot change the wallpaper of our desktop.
3. The Find option is used to locate a specific word or text in a document.
4. By default, Word uses a blue square as a bullet.

C. Fill in the blanks :
1. A pendrive is also known as a :
2. is where we will find our app notifications.

3. Word has an in-built dictionary called :
4, A list is used for listing when the order of items is important.

D. Answer the following questions :
1. Explain blu-ray disc and memory cards.
2. How can you change the appearance of the Start menu in Windows 107?
3.  What do you mean by editing?
4.  What is the use of Superscript and Subscript options?

E. Draw and colour the logo of MS Word 2019.
4 )
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Model Test Paper-

A. Tick (v) the correct answer :

1. To change the layout of a selected slide, click on the option.
(a) New Slide (b) Reset (c) Layout (d) Theme
2.  Which of the following operators is used for multiplication?
(a) / (b) * (c) - (d) Both (a) & (b)
3.  Which of the following is not an ISP?
(a) Jio (b) BSNL (c) Airtel (d) Google Chrome
4, It creates another copy of the sprite.
(a) Delete (b) Duplicate (c) Grow (d) Shrink

B. Write ‘T’ for true and ‘F’ for false in the given circles :
1. Once we select a slide layout, we cannot change it.
2. We cannot change the size of the font used in print command.
3. A webpage is created using a language called HTML.
4. A programming language has a set of instructions called program.

C. Fill in the blanks :

1. view hides all the editing tools to make our slides easier to Review.
2. The +, —, * and / symbols are called operators.

3. When we visit any site, the first page that opens is called the

4. The tab allows us to record or import sound files for a sprite.

D. Answer the following questions :
1. What do you mean by presentation?
2. What is the use of print command?
3. Define ISP and WWW.
4.  What is Scratch?

E. Draw and colour any one Sprite.
4 )
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